Contents

About This Guide  vii
1 Available Documentation ................................................................. vii
2 Feedback .......................................................................................... ix
3 Documentation Conventions .............................................................. x

I Introduction  1

1 Getting Started with the KDE Desktop  3
1.1 Logging In ..................................................................................... 3
1.2 Exploring the Desktop Components ................................................. 5
1.3 Leaving Your System ...................................................................... 13
1.4 Switching Desktops ......................................................................... 14

2 Working with Your Desktop  17
2.1 Starting Programs ............................................................................ 17
2.2 Using Dolphin File Manager ............................................................. 21
2.3 Moving Text between Applications ............................................... 26
2.4 Finding Data on your Computer or in the File System ....................... 27
2.5 Accessing Removable Media and External Devices ......................... 30
2.6 Using Virtual Desktops ..................................................................... 31
2.7 Managing Internet Connections ...................................................... 32
2.8 Exploring the Internet .................................................................... 32
2.9 E-Mail and Scheduling ................................................................... 32
2.10 Instant Messaging ................................................................. 33
2.11 Managing Passwords ......................................................... 33
2.12 Opening or Creating Documents with LibreOffice ............... 34
2.13 Viewing PDF Files and Other Documents ............................ 34
2.14 Taking Screen Shots .......................................................... 34
2.15 Displaying, Decompressing, and Creating Archives ............... 35
2.16 Creating CDs or DVDs ....................................................... 37
2.17 Viewing and Managing Digital Images ................................. 37
2.18 Managing Your Music Collection ........................................ 38
2.19 Troubleshooting ............................................................... 38
2.20 For More Information ....................................................... 39

3 Customizing Your Settings 41
3.1 Personal Settings - Overview ............................................... 41
3.2 Configuring Desktop Objects and Appearance ...................... 44
3.3 Configuring Hardware Components ...................................... 52
3.4 Configuring Behavior and System Aspects ............................ 58

II Managing Files and Resources 65

4 Viewing PDF Files and Other Documents with Okular 67
4.1 Viewing PDF Files ............................................................ 67
4.2 Annotating a PDF File ....................................................... 68
4.3 For More Information ....................................................... 69

5 Accessing Network Resources 71
5.1 General Notes on File Sharing and Network Browsing .......... 72
5.2 Accessing Network Shares ................................................ 73
5.3 Sharing Folders in Mixed Environments ............................... 73
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.4 Managing Windows Files</td>
<td>76</td>
</tr>
<tr>
<td>5.5 Configuring Shortcuts to Network Folders</td>
<td>80</td>
</tr>
<tr>
<td><strong>6 Searching with Kerry</strong></td>
<td><strong>81</strong></td>
</tr>
<tr>
<td>6.1 Searching Using Kerry</td>
<td>81</td>
</tr>
<tr>
<td>6.2 Configuring Kerry</td>
<td>82</td>
</tr>
<tr>
<td><strong>7 Managing Print Jobs</strong></td>
<td><strong>85</strong></td>
</tr>
<tr>
<td><strong>8 Managing Passwords with KWallet Manager</strong></td>
<td><strong>87</strong></td>
</tr>
<tr>
<td>8.1 Starting KWallet</td>
<td>87</td>
</tr>
<tr>
<td>8.2 Managing Your Passwords</td>
<td>88</td>
</tr>
<tr>
<td>8.3 Adjusting KWallet Settings</td>
<td>90</td>
</tr>
<tr>
<td>8.4 Copying Your Wallet to Another Computer</td>
<td>91</td>
</tr>
<tr>
<td><strong>9 Controlling Your Desktop's Power Management</strong></td>
<td><strong>93</strong></td>
</tr>
<tr>
<td>9.1 Using the Battery Monitor Widget</td>
<td>93</td>
</tr>
<tr>
<td>9.2 Saving Power by Using Profiles</td>
<td>95</td>
</tr>
<tr>
<td>9.3 Configuring Power Management</td>
<td>96</td>
</tr>
<tr>
<td>9.4 For More Information</td>
<td>98</td>
</tr>
<tr>
<td><strong>A GNU Licenses</strong></td>
<td><strong>99</strong></td>
</tr>
<tr>
<td>A.1 GNU Free Documentation License</td>
<td>99</td>
</tr>
</tbody>
</table>
About This Guide

This manual introduces the KDE 4 desktop of SUSE® Linux Enterprise Desktop. It helps you perform key tasks. It is intended mainly for end users who want to make efficient use of KDE in everyday life.

Many chapters in this manual contain links to additional documentation resources. These include additional documentation that is available on the system as well as documentation available on the Internet.

For an overview of the documentation available for your product and the latest documentation updates, refer to http://www.suse.com/doc or to the following section.

1 Available Documentation

We provide HTML and PDF versions of our books in different languages. The following manuals for users and administrators are available for this product:

KDE User Guide (page i)
Introduces the KDE desktop of SUSE Linux Enterprise Desktop. It guides you through using and configuring the desktop and helps you perform key tasks. It is intended mainly for users who want to make efficient use of KDE as their default desktop.

GNOME User Guide (↑GNOME User Guide)
Introduces the GNOME desktop of SUSE Linux Enterprise Desktop. It guides you through using and configuring the desktop and helps you perform key tasks. It is intended mainly for end users who want to make efficient use of GNOME desktop as their default desktop.

Application Guide (↑Application Guide)
Learn how to use and configure key desktop applications on SUSE Linux Enterprise Desktop. This guide introduces browsers and e-mail clients as well as office applications and collaboration tools. It also covers graphics and multimedia applications.
**Deployment Guide (Deployment Guide)**
Shows how to install single or multiple systems and how to exploit the product inherent capabilities for a deployment infrastructure. Choose from various approaches, ranging from a local installation or a network installation server to a mass deployment using a remote-controlled, highly-customized, and automated installation technique.

**Administration Guide (Administration Guide)**
Covers system administration tasks like maintaining, monitoring, and customizing an initially installed system.

**Security Guide (Security Guide)**
Introduces basic concepts of system security, covering both local and network security aspects. Shows how to make use of the product inherent security software like AppArmor (which lets you specify per program which files the program may read, write, and execute), and the auditing system that reliably collects information about any security-relevant events.

**System Analysis and Tuning Guide (System Analysis and Tuning Guide)**
An administrator's guide for problem detection, resolution and optimization. Find how to inspect and optimize your system by means of monitoring tools and how to efficiently manage resources. Also contains an overview of common problems and solutions, and of additional help and documentation resources.

**Virtualization with Xen (Virtualization with Xen)**
Offers an introduction to virtualization technology of your product. It features an overview of the various fields of application and installation types of each of the platforms supported by SUSE Linux Enterprise Server as well as a short description of the installation procedure.

In addition to the comprehensive manuals, several quick start guides are available:

**KDE Quick Start (KDE Quick Start)**
Gives a short introduction to the KDE desktop and some key applications running on it.

**GNOME Quick Start (GNOME Quick Start)**
Gives a short introduction to the GNOME desktop and some key applications running on it.
LibreOffice.org Quick Start

Gives a short introduction into the LibreOffice suite and its modules for writing texts, working with spreadsheets, or creating graphics and presentations.

Installation Quick Start

Lists the system requirements and guides you step-by-step through the installation of SUSE Linux Enterprise Desktop from DVD, or from an ISO image.

Linux Audit Quick Start

Gives a short overview how to enable and configure the auditing system and how to execute key tasks such as setting up audit rules, generating reports, and analyzing the log files.

AppArmor Quick Start

Helps you understand the main concepts behind AppArmor®.

Find HTML versions of most product manuals in your installed system under /usr/share/doc/manual or in the help centers of your desktop. Find the latest documentation updates at http://www.suse.com/doc where you can download PDF or HTML versions of the manuals for your product.

2 Feedback

Several feedback channels are available:

Bugs and Enhancement Requests

For services and support options available for your product, refer to http://www.suse.com/support/.

To report bugs for a product component, log in to the Novell Customer Center from http://www.suse.com/support/ and select My Support > Service Request.

User Comments

We want to hear your comments about and suggestions for this manual and the other documentation included with this product. Use the User Comments feature at the bottom of each page in the online documentation or go to http://www.suse.com/doc/feedback.html and enter your comments there.
Mail

For feedback on the documentation of this product, you can also send a mail to doc-team@suse.de. Make sure to include the document title, the product version, and the publication date of the documentation. To report errors or suggest enhancements, provide a concise description of the problem and refer to the respective section number and page (or URL).

3 Documentation Conventions

The following typographical conventions are used in this manual:

- `/etc/passwd`: directory names and filenames
- `placeholder`: replace `placeholder` with the actual value
- `PATH`: the environment variable PATH
- `ls, --help`: commands, options, and parameters
- `user`: users or groups
- `Alt, Alt + F1`: a key to press or a key combination; keys are shown in uppercase as on a keyboard
- `File, File > Save As`: menu items, buttons
- `Dancing Penguins (Chapter Penguins, ↑Another Manual)`: This is a reference to a chapter in another manual.
Part I. Introduction
Getting Started with the KDE Desktop

This chapter assists you in becoming familiar with the KDE desktop of your SUSE® Linux Enterprise Desktop. If you have not yet installed your system, refer to Chapter 3, Installation with YaST (↑Deployment Guide) or to Installation Quick Start (↑Installation Quick Start).

KDE stands for K Desktop Environment and is an easy-to-use graphical user interface that communicates with the underlying Linux system to access and manage files, folders, and programs. It has many applications designed to help you in your daily work. KDE also offers many choices to modify your desktop according to your needs and wishes. Read more about configuring your desktop in Chapter 3, Customizing Your Settings (page 41).

The following description is based on the default configuration of the KDE 4 desktop shipped with your product. If you or your system administrator has modified the defaults, some aspects may be different, such as appearance or keyboard shortcuts.

1.1 Logging In

If more than one user account is configured on your computer, usually all users must authenticate—unless Auto Login is configured for a certain user. Auto login logs the user in to the desktop environment automatically on boot. This feature can be enabled or disabled during installation or at any time using the YaST user management module. For more information, see Chapter 9, Managing Users with YaST (↑Deployment Guide).

If your computer is run in a network environment and you are not the only person using the machine, you are usually prompted to enter your username and password when
you start your system. If you did not set up your system and your user account yourself, check with your system administrator for your username and password.

The appearance of the login screen depends on the product you use and on the desktop environment installed on your system. The login process is managed by an application. For KDE, it is KDM. If the GNOME desktop is additionally installed on your system, it may be GDM.

To start a normal login, enter your username and password. If desktops other than KDE are installed, you can select which desktop environment to start by clicking the Session Typing menu item at the bottom of the login screen. Press Enter to proceed. For information on how to log out or switch to another desktop, see Section 1.3, “Leaving Your System” (page 13) and Section 1.4, “Switching Desktops” (page 14).

**Figure 1.1:** A KDM Login Screen

If your system administrator has created an encrypted home directory for you (which is useful as a protection against theft or unauthorized removal of the hard disk), your home directory is mounted on login. After login, you can directly access the data as usual—without entering another password.

---

**NOTE: Connecting to an Active Directory Server**

To access shared network resources, you can also authenticate a KDE client machine against an Active Directory server. For further details, refer to Chap-
ter 5, *Accessing Network Resources* (page 71). If your machine is configured for this kind of authentication, the login screen also provides an additional field. In this case, proceed as follows during login:

1. Select the domain from the list.
2. Enter your Windows username.
3. Enter your Windows password and press Enter.

---

### 1.2 Exploring the Desktop Components

After logging in to KDE for the first time, you see the KDE desktop. It consists of the following basic elements:

*Figure 1.2: Example KDE Desktop*

**Desktop Icons and Desktop Folder:** Desktop icons represent files, directories, applications, functions, and removable media, like CDs or DVDs. Click an icon on the desktop to access its associated program or application. By default, your desktop icons
are shown in a Desktop Folder, a transparent region of the screen showing the contents of the Desktop folder of your home directory. If you drag an icon from the Desktop Folder and drop it on another part of the desktop, it appears as a widget that you can tilt, enlarge or minimize. Widgets are small applications that can be integrated into your desktop. Right-click to open a context menu to access the icon properties, or to remove the icon. For more information, see Procedure 3.3, “Configuring Widgets” (page 45).

**Desktop Context Menu:** Right-click an empty area on the desktop to access the context menu for configuring the appearance of the desktop, adding panels or widgets to the desktop, locking the widgets in their current position, or for leaving the current session or locking the screen.

**Desktop Toolbox:** (Only visible if the desktop is not set to Plain Desktop View. For more information, see Procedure 3.6, “Using Different Options for Each Virtual Desktop” (page 48).) Move your mouse pointer to the icon in the upper right corner of the desktop to access a menu that lets you configure desktop widgets. For the Add Widgets and Lock Widgets function, refer to Section 1.2.1, “Locking and Unlocking Desktop Objects” (page 7) for more information.

**KDE Panel:** The panel (in KDE also called “Kicker”) is a bar, typically located at the top or the bottom of the screen. By default, the panel of your KDE desktop consists of the following areas (from left to right): quick launcher with the main menu icon on the left and further program icons, pager (desktop previewer), taskbar, and system tray. You can add or remove icons in the panel and customize the appearance of the panel as well as its location on the desktop. If you hold your mouse pointer over an icon in the panel, a short description is displayed.

**Quick Launcher:** The quick launcher contains the main menu button and some larger icons that are shortcuts to frequently used programs, folders, and functions.

**Main Menu Button:** Use the icon at the far left of the panel to open a menu holding a search function at the top and several tabs at the bottom. The Applications tab shows all installed programs in a function-oriented menu structure which makes it easy to find the right application for your purpose, even if you do not know the application names yet. For more information, refer to Section 2.1.1, “Using the Main Menu” (page 18).

**Pager (Desktop Previewer):** Between the quick launcher and the taskbar, find a miniature preview that shows your virtual desktops (if not configured otherwise,
they are numbered). SUSE Linux Enterprise Desktop allows you to organize your programs and tasks on several desktops, which minimizes the number of windows to arrange on the screen. To switch between the virtual desktops, click one of the symbols in the pager. For more information, refer to Section 2.6, “Using Virtual Desktops” (page 31).

**Taskbar:** By default, all started applications and open windows are displayed in the taskbar, which allows you to access any application regardless of the currently active desktop. Click to open the application. Right-click to see options for moving, restoring, or minimizing the window.

**System Tray:** This rightmost part of the panel usually holds some smaller icons, including the system clock displaying time and date, the volume control, and several other helper applications.

The integration and handling of desktop objects has changed from KDE 3.x to KDE 4, which now uses a new desktop and panel interface tool called Plasma. Plasma supports desktop widgets (also called “plasmoids”), similar to Apple’s dashboard widgets. Learn more about the key desktop objects in the following sections.

### 1.2.1 Locking and Unlocking Desktop Objects

With KDE 4, desktop elements can be locked in their current position to prevent them from being moved around on the desktop. As long as the desktop elements are locked, you cannot add, move, or remove any objects to and from your desktop.

To lock or unlock the desktop elements, right-click an empty space on the desktop and select *Lock Widgets* or *Unlock Widgets*. 
Find how to add, remove and configure widgets and change numerous desktop elements in Chapter 3, *Customizing Your Settings* (page 41).

### 1.2.2 Desktop Icons

By default the *Desktop Folder*, showing the contents of the `~/Desktop` folder, displays the following icons:
**My Computer**

The *My Computer* icon is very useful for viewing the most important information about your hardware, network status, disks (hard disks, removable media, and external devices), operating system, and some common folders at one glance. For example, find processor type and speed listed there, information about your RAM and the current swap status, or your graphics card. *OS Information* lists the most important information about your operating system, such as the Kernel version included, the current user, version number and type of the operating system, as well as the KDE version number. SUSE Linux Enterprise Desktop ships with a number of further tools (either graphical or command line tools) that you can use to get more detailed information about your system. If you need detailed hardware information about your system, use the YaST hardware probing, described in Section “Hardware Information” (Chapter 5, *Setting Up Hardware Components with YaST*, ↑*Deployment Guide*).

**Firefox**

Opens the Firefox Web browser. For more information, refer to Chapter 15, *Firefox: Browsing the Web* (↑*Application Guide*).

**Office**

Opens LibreOffice. For an introduction to the office suite, refer to Chapter 1, *LibreOffice: The Office Suite* (↑*Application Guide*).
1.2.3 Panel Icons

The panel can be subdivided into three main areas holding icons: the quick launch area at the left, the taskbar in the middle and the system tray at the right. The taskbar has dynamic contents, showing the currently started applications and windows with their icons, whereas quick launcher and system tray are more static.

1.2.3.1 Quick Launch Area

The quick launch area of your panel as shipped with SUSE Linux Enterprise Desktop, includes the following icons by default:

**Figure 1.5:** Panel: Quick Launch Area

Main Menu Icon
- Opens the main menu, similar to the Microsoft* Windows start menu. For more information, refer to Section 2.1.1, “Using the Main Menu” (page 18).

Show Dashboard Icon
- Hides all open windows and puts the widgets in front of them. Shows the cashew icon in the right upper corner of the desktop from which you can access a menu to configure your plasma workspace. For more information, refer to Procedure 3.6, “Using Different Options for Each Virtual Desktop” (page 48).

Firefox Icon
- Starts the Firefox Web browser. For more information, refer to Chapter 15, Firefox: Browsing the Web (↑Application Guide).

Dolphin Icon
- Opens Dolphin, the default file manager. For more information, refer to Section 2.2, “Using Dolphin File Manager” (page 21).
Device Notifier Icon
Informs you about recently plugged or inserted devices such as USB sticks, external hard disks, cameras, CDs, and DVDs. For more information, refer to Section 2.5, “Accessing Removable Media and External Devices” (page 30).

1.2.3.2 System Tray

Apart from the larger icons in the quick launcher, the panel also holds a number of smaller icons in the system tray area on the right:

*Figure 1.6: Panel: System Tray*

- **Klipper**
  KDE's clipboard tool that “remembers” the last entries you have moved to the clipboard. To view the clipboard contents, click the Klipper icon or press Ctrl + Alt + V. The most recent entry is listed on top and is marked as active with a black check mark. To insert the active clipboard entry again, move the mouse pointer to the target application, then middle-click. For more information on using Klipper, see Section 2.3, “Moving Text between Applications” (page 26).

- **Update Applet**
  Helps you keep your system up-to-date. When you connect to the Internet, the update applet automatically checks whether software updates for your system are available. The applet icon changes color and appearance depending on the availability of updates for your system. For detailed information on how to install software updates with the updater applet and how to configure it, refer to Chapter 1, *YaST Online Update (↑Administration Guide).*

- **KMix**
  Your desktop's default mixer (KMix) helps you to control sound on your desktop after your sound card has been detected and configured with YaST. By default, clicking the KMix icon in the system tray shows the master controller with which to increase or decrease the overall volume. For more information, refer to Section “Mixers” (Chapter 20, *Amarok, Kaffeine and More: Playing Music and Movies, ↑Application Guide*).
NetworkManager
If you manage your network connection with NetworkManager and have enabled the use of NetworkManager in YaST, the NetworkManager icon also appears in your system tray by default. Use it to change and configure network connections. For detailed information, refer to Chapter 26, Using NetworkManager (↑Administration Guide).

Job & Notifications
This icon shows running jobs on your desktop (for example, if you are copying files) and notifies you about system events. Jobs are grouped to prevent the pop-up of too many dialogs and are automatically hidden after a few seconds. Animations signify that jobs are still running. Usually, the entries are automatically destroyed after some time, but in case you do not use your desktop during that time, they are retained, so you can safely stay away from your computer for a couple of hours, and when you come back, you will still be able to see which jobs have been finished during your absence. To configure which information to show or to disable auto-hiding, right-click the Job & Notifications icon and select System-Tray Settings.

Clock
For information about the current date and time, click the clock in the system tray or move your mouse pointer over the clock. You can change the clock settings (such as appearance and additional data to be displayed) from the context menu available upon right-click. If you need to update the system time, start YaST and select System > Date and Time. Refer to Section “Clock and Time Zone” (Chapter 3, Installation with YaST, ↑Deployment Guide) for more information.

Lock Screen
Locks your screen and starts the screen saver. Access to the session can only be regained with a password.

Log Out
Logs you out and ends your current KDE session. If not configured otherwise in the KDE 4 Personal Settings (see Procedure 3.16, “Adjusting the Session Handling” (page 62), the session manager will restore the currently open windows by default next time you log in to KDE.

Cashew Icon
Give access to panel configuration options. For more information, see Procedure 3.8, “Customizing the Panel” (page 50).
You can change the way your KDE desktop looks and behaves to suit your own personal tastes and needs. To learn how to configure individual desktop elements or how change the overall appearance and behavior of your desktop, refer to Section 3.1, “Personal Settings - Overview” (page 41).

If you would like to start working with your desktop now, continue reading at Chapter 2, *Working with Your Desktop* (page 17). Otherwise you can leave your system with one of the possibilities described below.

### 1.3 Leaving Your System

When you have finished using the computer, there are several options for leaving your system. Some of them will leave the system running, others will shutdown the computer. If your system provides power management, you can also choose to *suspend* your computer. In this state, it will consume considerably less power than usual and will start much faster than after a complete shutdown and reboot. For more information, refer to Chapter 9, *Controlling Your Desktop's Power Management* (page 93).

You can access all the options to leave your system from the main menu. Click the main menu icon on the left and switch to the *Leave* tab. Select one of the following options:

**Logout**

Ends your current session and leaves your system running. If not configured otherwise in the KDE 4 Personal Settings, the session manager will restore the currently open windows by default the next time you log in to KDE 4. Find more information about the session manager and configuration options at Procedure 3.16, “Adjusting the Session Handling” (page 62).

**Lock**

Prevents unauthorized access by others by locking your screen and starting a screen saver. Access to the session can only be regained with a password. To unlock, enter your normal login password. For information about configuring your screen saver, see Procedure 3.7, “Configuring the Screen Saver” (page 49).

**Switch User**

Starts a second session with a graphical user interface on your machine. Your current session remains active while you are taken to the login screen where you can log in as a different user. You can access the first session again by pressing Ctrl +
Alt + F7. To access a new session, press F8 instead of F7. Additional sessions can be accessed by pressing Ctrl + Alt + F9 to F12.

If more than one desktop environment is installed on your system, you can also choose to switch to another desktop for the new session as described in Section 1.4, “Switching Desktops” (page 14).

Suspend to Disk
This menu item is only available if your computer provides power management functionality. Pauses your computer without logging you out. All your data and the session data is saved to disk before the system is laid to rest. It is thus protected against data loss should you lose power in the meantime. Waking the system up again is much faster than with a fresh boot.

Suspend to RAM
This menu item is only available if your computer provides power management functionality. Pauses your computer without logging you out. All your data and the session data is saved to RAM. Bringing the system up again is faster than restoring a session from disk.

Shutdown Computer
Logs you out and turns your computer off.

Restart Computer
Initiates the shutdown process and reboots your computer. Instead of selecting the desired boot option in the boot manager, you can also select the desired option directly—just click one of the options below Restart Computer.

Alternatively, you can also use the desktop context menu or the icons in the system tray to leave your system.

If you have already logged out, you can still access shutdown and restart option from the login screen by clicking Menu and selecting the relevant menu items.

1.4 Switching Desktops
If more than one desktop environment is installed on your system (for example, KDE and GNOME, or KDE 3.5.x and KDE 4), you can choose to switch to another desktop when logging in again (or when logging in as a different user). To do so, proceed as follows:
1 On the login screen, click *Session Type* and select the desktop environment to start.

2 Enter a valid username and password. A new session on the selected desktop environment starts.

3 To switch back again, log out from the current desktop and select a different *Session Type* on the login screen. If you do not select a new session type, your next session will be of the same type as the session before.
Working with Your Desktop

The following sections give you a short introduction to the key functionalities and applications. Learn how to cope with basic and daily tasks and how small KDE utilities like a password manager or a clipboard tool can ease your life.

2.1 Starting Programs

You can start programs either from the main menu or from the command line, using the Run Command dialog or a shell. Additionally, you can start programs from the desktop or the panel by left-clicking the program icon once.

TIP: Selecting and Starting Objects

Clicking an object once in SUSE Linux Enterprise Desktop usually starts an action directly: a program starts, a preview of the file is displayed, or the folder is opened. To former users of Windows, this behavior may be rather unusual. If you just want to select one or several objects without any other action, press Ctrl then click the object. Alternatively, alter your mouse settings in the KDE Personal Settings as described in Procedure 3.11, “Adjusting the Mouse Settings” (page 54).
2.1.1 Using the Main Menu

To open the main menu, click the main menu icon in the panel or press Alt + F1. The main menu consists of the following elements: a search function at the top and several tabs at the bottom, providing quick access to the key functions of the menu.

The following tabs are available:

* **Favorites**
  Shows a default selection of key programs for quick access.

* **Applications**
  Shows all applications installed on your system. The function-oriented menu structure makes it easy to find the right application for your purposes even if you do not know the application name yet. To navigate through the structure, click an entry and use the arrow icons at the right or the left to switch back and forth. To switch back to the top-level hierarchy from anywhere in the structure, just click the tab's name or icon.

* **Computer**
  Gives quick access to some places often needed, such as important system folders (home directory, network folders) and media devices. Also allows you to quickly
access system information, and to change your system configuration with YaST, if necessary.

Recently Used
Lists the most recently opened programs and files. To reopen a program or file, just click the entry. To remove all recently used programs or files from the list, right-click below the relevant heading and select *Clear Recent Applications* or *Clear Recent Documents*.

Leave
Shows several options for leaving the session, such as logging out, locking the screen (access can only be regained with a password), shutting down or restarting the computer. For more information, see Section 1.3, “Leaving Your System” (page 13).

Additionally, the menu displays your login name and the hostname of your computer. This information is useful when you are logged in as a different user or to a remote computer—it always shows you which system you are currently working on.

### 2.1.2 Using KRunner

KRunner is a helper application which lets you quickly start programs. It also offers a search function for finding applications or locations. Refer to Section 2.1.3, “Searching for Programs” (page 21) for more information.

Press Alt + F2 to open the input field. Type a command, for example, *dolphin*, and press Enter to start the application. The command to start the application is often (but not always) the application name written in lowercase.
You can also use KRunner to show current processes running on your system. To do so, start KRunner and click the *Show System Activity* icon. The dialog that appears also allows you to kill processes (for example, to terminate a “runaway” application).

KRunner's abilities can be extended by a huge number of plug-ins that provide additional functionality. For example, if the *Web Shortcuts* plug-in is activated, you can use the Web shortcuts defined in Konqueror also in KRunner: send search requests directly to a search engine like Google without opening the browser and visiting the Web sites before. For more information, refer to Section “Using Web Shortcuts” (Chapter 14, *Konqueror: Browsing the Web*, ↑Application Guide).

Click the wrench symbol to explore the full range of KRunner's abilities: If the *Contacts* plug-in is activated, just enter the name of one of your contacts and then press *Enter* to open KMail and to start typing your mail.

If the relevant plug-in is activated, you can also use KRunner as a calculator or to convert units.
2.1.3 Searching for Programs

Both the main menu and KRunner offer a search function that lets you quickly start programs, even if you do not know the exact application name or command yet. To search for an application, start typing a command or part of the application name in the main menu Search field of the menu or the input field in the Run Command dialog. Each character you enter further narrows your search.

From the list below the input field, choose the application or object matching your query.

2.2 Using Dolphin File Manager

With KDE 4, Dolphin has replaced Konqueror as the default file manager, while Konqueror still functions as Web browser. For more information about Konqueror as Web browser, see Chapter 14, Konqueror: Browsing the Web (↑Application Guide). To start Dolphin, click the card box icon in the panel or press Alt + F2 and enter dolphin.

2.2.1 Dolphin Main Window

The Dolphin main window consists of the following elements:
Menu Bar: The menu bar holds menu items for actions like copying, moving, and deleting files, changing views, starting additional tools, defining your settings, and getting help.

Toolbar: The toolbar provides quick access to frequently used functions that can also be accessed via the menu. If you hover the mouse pointer over an icon, a short description is displayed.

Location Bar: The location bar displays the path to the current directory. It is available in two versions. One shows the path to the current directory with icons for every parent folder in a “bread crumb” view. Click any icon in the bread crumb view to change to that directory. The second version of the location bar shows the path to the current directory as a string of text you can edit.

Panels: By default, Dolphin shows only the Places panel on the left and the Information panel on the right. Places allows quick access to some often used places like your home directory, the /root directory of the file system, the trash bin, or removable media. There are several other panels you can add to the main window.

Display Field (Working Space): The display field shows the contents of the selected directory or file. By default, Dolphin displays the contents of your home directory on
start-up. Clicking a folder or file in Dolphin directly starts an action: Dolphin loads the file into an application for further processing, or opens the folder.

**Status Bar:** Shows information about the currently selected object.

### 2.2.2 Opening Files or Folders in Dolphin

If not configured otherwise in the Personal Settings, clicking an object once in Dolphin usually starts an action directly: a program starts, a preview of the file is displayed, or the folder is opened. For each file type, you can define a default application with which to open the file in KDE, for example, when it is clicked in Dolphin. To view or change the default application assigned to the file type, proceed as described in Procedure 3.14, “Changing File Associations” (page 60). If KDE cannot find a default application for the file type (or if you want to open a file with a different application than usual), right-click the file in Dolphin and select *Open With*. If several applications are assigned to that file type, select the respective entry. Otherwise click *Other* to select an application from the main menu with which to open the file.

### 2.2.3 Managing Files and Folders

To perform actions like copying, moving, creating or deleting files, you need appropriate permissions to the folders and files involved in your action.

**Procedure 2.1:** *Copying, Moving, or Delete Files or Folders*

1. In order to select one or multiple files and folders in Dolphin, move your mouse pointer over the file or folder but do not click. A green cross appears on the upper-left edge. To select the file or folder now, click the green cross icon. Alternatively, press **Ctrl** and click the file or files. To deselect again, click the red minus icon that appears if the object is currently selected.

2. Right-click and select *Copy* or *Cut* from the context menu.

3. Navigate to the destination folder in which to insert the object.

4. To create a new folder at the current location, select *File > Create New > Folder* or press F10. Enter a folder name in the new window and press Enter.
5 To insert the object you copied or cut in Step 2 (page 23), right-click the destination folder in the main display field and select *Paste*. The object is copied or moved there.

6 To delete a file or folder, right-click the object in the main display field and select *Move to Trash* from the context menu. The object is moved to the trash bin. From there, you can restore it if necessary or delete the object irretrievably.

To quickly filter for certain filenames in the current directory, press Ctrl + I or select *Tools > Show Filter Bar* to add the *Filter* input field to the bottom of the Dolphin main window. Type any part of the filename you are searching for to see all files in the current directory containing the search string. For more detailed and advanced searches, press Ctrl + F to use KFind. For more information, refer to Section 2.4, “Finding Data on your Computer or in the File System” (page 27).

### 2.2.4 Configuring Dolphin

Dolphin offers many options to adjust the view and the overall settings according to your needs.

**Procedure 2.2: Changing the View**

1 To toggle between the bread crumb view and the editable version of the location bar, press Ctrl + L or click at the far right end of the location bar. Enter a path to a directory by typing it in. After typing an address, press Enter.

   ![Dolphin Toolbar Options](image)

   To delete the contents of the location bar click the black X symbol on the left. To switch back to the bread crumb view, press Ctrl + L.

2 To change the view of the currently displayed folder, either click *Icons, Details, or Columns* in the toolbar. Dolphin remembers the selected view for each folder. Alternatively, press Ctrl + 1, Ctrl + 2, or Ctrl + 3 to switch between the view modes. Click *Split* or press F3 to view the contents of the current folder in two separate columns. Now you can navigate to a different directory in each column and easily drag or drop objects or compare the contents of directories.
3 To make Dolphin also show hidden files, select View > Show Hidden Files or press Alt + .

4 To view more details about the files (like access permissions or ownership), select View > Additional Information and enable the relevant options.

5 To add further directories to the Places panel, drag a folder from the working space to the Places panel and drop it there. Right-click and use the context menu to hide, edit or remove entries from Places.

6 If you want to add more panels to the main window, select View > Panels and select additional panels such as Information, Folders, or Terminal.
• The *Information* panel shows the properties and a preview of the currently selected file. It also lets you add comments to the file.

• The *Folder* panel shows a tree view of the whole file system and lets you navigate through all subdirectories of `/root`.

• The *Terminal* panel attaches a command line to the bottom of the main Dolphin window. Whenever you click a directory in the display field, the *Terminal* panel also changes to that directory, so you can easily switch to the command line for certain tasks you prefer to execute in a shell.

You can even detach the panels from the main Dolphin window by clicking the left icon at the top of each panel. Click the panel's title bar and drag it to another place on the desktop. To reintegrate the panel into the Dolphin window again, click the left symbol at the top of the panel again.

**Procedure 2.3: Changing Dolphin's Overall Behavior**

If you want to change Dolphin's overall behavior or view, select *Settings > Configure Dolphin* and explore the options offered in the Dolphin configuration dialog.

1. To use the same view mode for all folders, click the *General* category in the left sidebar. On the *Behavior* tab, activate *Use Common View Properties for All Folders*. If you want to adjust the options for the individual view modes, click *View Modes* in the left sidebar and set the options according to your wishes. Click *Apply* to save the changes.

2. If you want Dolphin to show a different default directory on start-up, or if you want to permanently use the editable location bar instead of the bread crumb view, change the relevant options in the *Startup* category.

3. Click *OK* to save the changes and to close the Dolphin configuration dialog.

**2.3 Moving Text between Applications**

To copy text to the clipboard and insert it again, former MS Windows users automatically try the keyboard shortcut `Ctrl + C` and `Ctrl + V`, which often works in Linux as
well. Copying and inserting texts is even easier in Linux: to copy a text to the clipboard, just select the text with the mouse then move the mouse cursor to the position to which to insert the text. Click the middle (or wheel) button on the mouse to insert the text (on a two-button mouse, press both mouse buttons simultaneously).

With some applications, if text is already selected in the application where you want to insert the text, this method does not work because the text in the clipboard is overwritten by the other selected text. For such cases, the KDE application Klipper is very useful. Klipper “remembers” the last entries you have moved to the clipboard. By default, Klipper is started when KDE is loaded and appears as a clipboard icon in the panel. To view the clipboard contents, click the Klipper icon or press Ctrl + Alt + V. The most recent entry is listed on top and is marked as active with a black check mark. If extensive text was copied to Klipper, only the first line of the text is displayed.

To copy an older text fragment from Klipper to the clipboard, click the respective entry in Klipper to select it. To insert the text fragment, move the mouse pointer to the target application, then middle-click. Some applications, such as LibreOffice, do not support middle-clicking for inserting texts from the clipboard. In this case, make sure the text you want to insert is selected in Klipper, then press Ctrl + V. For further information about Klipper, especially on how to configure selection behavior, see the Klipper online help.

## 2.4 Finding Data on your Computer or in the File System

KDE provides more than one application for finding data on your computer or in the file system. With Kerry, you can very easily search your personal information space (usually your home folder) to find documents, e-mails, Web history, IM/ITC conversations, source code, images, music files, applications, and much more. For more information, refer to Chapter 6, *Searching with Kerry* (page 81).

With KFind, you can locate files on your computer or in the file system using a variety of search criteria, such as file content, dates, owner, or file size. Start it from the main menu with *Applications > Find Files/Folders*. Alternatively, press Alt + F2 and enter kfind.
2.4.1 Finding Files

To perform a search for certain filenames, proceed as follows:

1. Start KFind from the main menu or command line.

2. Click the Name/Location tab to perform a basic search.

3. Specify the name of the file to find in Named. You can use the following wild cards:

   **Asterisk**
   
   The asterisk (*) stands for any number of missing characters (even zero). For example, searching for marc* can find the files marc, marc.png, and marc_must_not_read_this.kwd. Searching for mar*.kwd can find marketplace.kwd and marc_must_not_read_this.kwd.

   **Question Mark**
   
   The question mark (?) stands for exactly one character. For example, searching for mar? can find marc, but marc? cannot find anything if your files are named marc and marc.png. You can put as many question marks in the search term as you want. It finds exactly that number of characters.

   You can combine those two wild card symbols in any search term.
4 Specify the folder to search in Look In or click Browse to find the folder you want. Select Include Subfolders to also search all subfolders starting from your specified folder.

5 Press Enter or click Find.

2.4.2 Performing an Advanced File Search

For a more detailed search, you can also specify further options, such as text that the file to find must contain:

1 Start KFind from the main menu or the command line.

2 Click the Name/Location tab.

3 Specify the name of the file to find in Named.

4 Specify the folder in which to search in Look In or click Browse to find the folder.

5 Click the Contents tab.

6 In File Type, specify the type of file to find.

7 In Containing Text, enter the word or phrase that the file you are searching for must contain.

8 If you want to specify further options, click the Properties tab and choose the options you want.

9 Click Find to perform the search.

For detailed information about the search options available, refer to the KFind online help.
2.5 Accessing Removable Media and External Devices

If you insert removable media (such as CDs or DVDs) into your computer's drive, or connect external devices such as USB sticks, external hard disks, media players or digital cameras, these are usually automatically detected. In KDE 4, a panel widget alerts you to any recently plugged or inserted devices.

Figure 2.2: DeviceNotifier

Click on the entry to show the device's contents with Dolphin.

If the device is not automatically displayed in the device notifier, try to access it manually with Dolphin.

Start the Dolphin file manager and switch to the editable version of the location bar as described in Procedure 2.2, “Changing the View” (page 24). Enter /media to access any type of drive mounted there. If the medium has been detected, it is also listed in the Places panel. Click the relevant entry to show the contents. Digital cameras can also be accessed by entering the URL camera:/ into Dolphin's location bar. In case your camera is not automatically detected, configure it first with the KDE 4 Personal Settings or with digiKam as described in Section “Configuring Your Camera” (Chapter 18, DigiKam: Managing Your Digital Image Collection, ↑Application Guide). Navigate through the camera's directory structure until the files are shown. Use the usual Dolphin file management features to copy the files as desired.

Another way to access detected media devices is to click the My Computer icon on your desktop. The detected devices are listed in the Disk Information section.
NOTE: Removing Media Safely

If you want to remove or disconnect a device from your computer, make sure that the data on it is currently not being accessed by any application or user. Otherwise, you risk a loss of data. To safely remove the device, proceed as follows:

1. Open a view that displays the removable device (for example, with Dolphin or My Computer).

2. Right-click the device in the Places panel (or below Disk Information) and select Safely Remove or Eject. Safely Remove unmounts the device, after which you can disconnect it from your computer. Eject automatically opens the CD or DVD drive of your computer.

---

2.6 Using Virtual Desktops

The desktop environment allows you to organize your programs and tasks on several virtual desktops between which you can switch the pager in the panel (see Section 1.2, “Exploring the Desktop Components” (page 5)). If you often run a lot of programs simultaneously, this minimizes the number of windows to arrange on your screen. You might, for example, use one desktop for e-mailing and keeping your calendar and another for word processing or graphics applications.

Procedure 2.4: Moving an Application to Another Virtual Desktop

You can display a running application on one or all virtual desktops or move it to other desktops.

1. Open the application.

2. Right-click the title bar of the application.

3. Click To Desktop.

4. Select the desktop on which to place the application.
To switch between desktops, click the desired desktop in the pager in the panel.

Some users might need more desktops than provided by default. Learn how to add additional desktops in Procedure 3.5, “Adding Additional Virtual Desktops” (page 48).

2.7 Managing Internet Connections

To surf the Internet or send and receive e-mail messages or use Instant Messengers, you must have configured an Internet connection with YaST or NetworkManager. For more details, see Section “Configuring a Network Connection with YaST” (Chapter 23, Basic Networking, ↑Administration Guide) and Chapter 26, Using NetworkManager (↑Administration Guide).

2.8 Exploring the Internet

Once an Internet connection is established, either use Firefox or Konqueror for browsing. Konqueror is KDE’s Web browser but SUSE Linux Enterprise Desktop also includes Firefox. To start Konqueror or Firefox, press Alt + F2 and enter konqueror or firefox.

With features like tabbed browsing, pop-up window blocking, and download and image management, both browsers combine the latest Web technologies. Their easy access to different search engines helps you to find the information you need.

For more information about Firefox, see Chapter 15, Firefox: Browsing the Web (↑Application Guide). Learn more about Konqueror as a Web browser in Chapter 14, Konqueror: Browsing the Web (↑Application Guide).

2.9 E-Mail and Scheduling

For reading and managing your mails and appointments, you can use Kontact as your personal information management tool (PIM). Kontact combines KDE applications like KMail, KOrganizer, and KAddressBook into a single interface. This gives you easy ac-
cess to your e-mail, calendar, address book, and other PIM functionality. KMail can also manage multiple e-mail accounts, such as your private and business e-mails. To start Kontact, press \texttt{Alt + F2} and enter \texttt{kontact}.

Before you can send or receive mails, you must configure an e-mail account. When starting KMail for the first time, a configuration wizard appears that assists you in setting up your account. For detailed information about configuring and using Kontact, see Chapter 5, \textit{Kontact: E-Mailing and Calendaring} (\textsc{Application Guide}).

2.10 Instant Messaging

Kopete is an online messenger application that allows multiple partners connected to the Internet to chat with each other. Kopete currently supports a number of common messenger protocols. To be able to use instant messaging (IM), you must register with a provider offering IM services and configure a Kopete account.

To start Kopete, press \texttt{Alt + F2} and enter \texttt{kopete}. Learn more about Kopete in Chapter 11, \textit{Kopete: Instant Messaging} (\textsc{Application Guide}).

2.11 Managing Passwords

When you enter a password in a KDE application for the first time (in KMail or Konqueror, for example), you are asked if you want to store the password in an encrypted wallet. If you click \texttt{Yes}, KWallet wizard starts by default. KWallet is a password management tool that can collect all passwords and store them in an encrypted file. For more information on how to configure and use KWallet, refer to Chapter 8, \textit{Managing Passwords with KWallet Manager} (page 87).

Whereas KWallet is designed to centrally manage passwords for several KDE applications, Firefox also offers the ability to store data when you enter a username and a password on a Web site. If you accept by clicking \texttt{Remember}, the password will be stored on your hard disk in an encrypted format. The next time you access this site, Firefox will automatically fill in the login data.

To review or manage your passwords in Firefox, click \texttt{Edit > Preferences > Security > Saved Passwords}....
2.12 Opening or Creating Documents with LibreOffice

The office suite LibreOffice offers a complete set of office tools, including word processor, spreadsheet, presentation, vector drawing, and database components. Because LibreOffice is available for a number of operating systems, you can use the same data across different computing platforms. You can also open and edit files in Microsoft Office formats then save them back to this format, if needed.

Start LibreOffice from the main menu or click the Office icon on the desktop. You can also start individual components, like the word processor, by pressing Alt + F2 and entering oowriter.

For an introduction to LibreOffice, see Chapter 1, *LibreOffice: The Office Suite* (↑Application Guide) or view the help in an LibreOffice program.

2.13 Viewing PDF Files and Other Documents

Documents that need to be shared or printed across platforms can be saved as PDF (Portable Document Format) files, for example, in the LibreOffice suite. View them with Okular, the default KDE document viewer.

Start Okular from the main menu or press Alt + F2 and enter okular.

To open a document, select *File > Open* and choose the desired file from the file system. Navigate through the documents by using the navigation icons at the top or bottom of the window. If your PDF document provides bookmarks, you can access them in the left panel of the viewer.

Okular also allows you to review a document by highlighting certain text parts or adding annotations. For more information about working with Okular, see Chapter 4, *Viewing PDF Files and Other Documents with Okular* (page 67).

2.14 Taking Screen Shots
With KSnapshot, you can create snapshots of your screen or individual application windows. Start the program from the main menu or by pressing Alt + F2 and entering ksnapshot. On start-up, KSnapshot takes a snapshot of the screen and displays it as preview. You can choose to save the current snapshot, to open it with an graphics application or to copy it to the clipboard. Before creating a new snapshot, check if the options in the lower part of the window match your needs. For example, to automatically capture a dialog window or a certain region (instead of the full screen), adjust the Capture Mode. If you need to take some other actions first (like selecting a certain object in the window), adjust the Snapshot Delay and choose if to Include the window decorations or not. Then click New Snapshot to take a new snapshot which you then can save or edit further.

**Figure 2.3:** KSnapshot

2.15 Displaying, Decompressing, and Creating Archives

To save space on the hard disk, use a packer that compresses files and directories to a fraction of their original size. The application Ark can be used to manage such
archives. It supports common formats, such as zip, tar.gz, tar.bz2, lha, rar and LZMA/XZ.

Start Ark from the main menu or from the command line with ark.

**Figure 2.4:** Ark: File Archive Preview

Once you have opened an archive, perform various actions. *Action* offers options such as Add File, Add Folder, Delete, Extract, View, Edit With, and Open With.

**Procedure 2.5:** Creating an Archive

1. To create a new archive, select File > New.

2. Enter the name of the new archive in the dialog that opens, and specify the format using Filter.

   After confirming with Save or by pressing Enter, the Ark window shows an empty archive.

3. To fill the archive, drag and drop files and directories from the file manager into this window or click Add File or Add Folder to add the objects you want to add to the archive.

4. To remove a file from the archive, select the file and click Delete.

5. If all files to be archived are displayed in the window, just close Ark. Ark automatically compresses everything into the previously selected archive format and saves the archive.
Procedure 2.6: Viewing and Extracting Archives

1 To view the contents of an archive, start Ark and select File > Open to open the file. Alternatively, just drag the archive from an open file manager window to the Ark window.

2 To see a preview of individual files, select a file and click Preview.

3 To extract all files from the archive, click Extract.

   If you want to extract individual files from the archive only, select one or more files (by keeping the Ctrl key pressed) and click Extract. In the following dialog, you can still decide to save All Files or the Selected Files Only.

4 Enter the path to the Destination Folder, select if to Open Destination Folder After Extraction and click OK to extract the files.

2.16 Creating CDs or DVDs

If you possess a CD or DVD writer, you can burn files to a CD or DVD with K3b. To start K3b, press Alt + F2 and enter k3b. Learn more about K3b in Chapter 23, K3b: Burning CDs and DVDs (↑Application Guide).

2.17 Viewing and Managing Digital Images

You can view digital images in the file manager or with Gwenview. Start Gwenview by pressing Alt + F2 and entering gwenview. Gwenview can load and save all image formats supported by KDE. It shows them either as thumbnails, in full screen view, or in slide show mode. When browsing JPEG images with EXIF information, Gwenview automatically rotates them according to the EXIF Orientation tag.

For managing and editing your digital images, digiKam is the right choice. Download your images from the camera, edit and improve them, organize them in albums (or flag them with tags for easy retrieval, independent of folders or albums), and archive them on CD (or export them to a Web image gallery).
To start digiKam, press Alt + F2 and enter digikam. Find an introduction to digiKam in Chapter 18, DigiKam: Managing Your Digital Image Collection (↑Application Guide).

2.18 Managing Your Music Collection

KDE’s Amarok music player allows you to play various audio formats, create playlists, and listen to streaming audio broadcasts of radio stations on the Internet. The file types supported depend on the engine used for Amarok. To start Amarok, press Alt + F2 and enter amarok. To define the folders where Amarok should look for your music files, from the main menu select Settings > Configure Amarok > Collection and set the options according to your wishes. For more information about Amarok, refer to Chapter 20, Amarok, Kaffeine and More: Playing Music and Movies (↑Application Guide).

2.19 Troubleshooting

Plasma Crashes
In case your desktop (or plasma crashes), use the following commands to kill and restart plasma:

```
 kbuildsycoca4
 kquitapp plasma-desktop
 kstart plasma-desktop
```

Plasma Configuration Files
If you ever need to manually modify the Plasma configuration files, find them in your system under ~/.kde4/share/config/plasmarc and ~/.kde4/share/config/plasma-appletsrc. The first one stores global settings like the desktop theme, while the latter stores the settings for all the individual applets.

Restoring Panels
If you accidentally deleted a custom panel, there is no way to restore it with all the elements it held. In this case, add a new panel as described in Procedure 3.8, “Customizing the Panel” (page 50) and start customizing it from scratch.

However, you can restore the default panel with the following steps:
1. Log out from the current KDE session.

2. Press Ctrl + Alt + F2 and log in on the command line with the same username.

3. Execute the following command:
   ```bash
   rm ~/.kde4/share/config/plasma-appletsrc
   ```

4. Press Ctrl + Alt + F7 and log back into the graphical user interface.

### 2.20 For More Information

As well as the applications described here for getting started, KDE can run many other applications. Find detailed information on many important applications in the other parts of this manual.


- Communicate and discuss topics with other KDE users and get help at [http://forum.kde.org/index.php](http://forum.kde.org/index.php).

- To learn more about the helper applications included in the KDE, see also [http://utils.kde.org/](http://utils.kde.org/).

- To report bugs or add feature requests, go to [http://bugs.kde.org/](http://bugs.kde.org/).
Customizing Your Settings

You can change the way your KDE desktop looks and behaves to suit your own personal tastes and needs. There are several ways to influence the look and feel of the KDE desktop depending on the scope of changes to make. For users, the following options are available:

- To change the appearance or behavior of individual desktop objects only, you can usually access a configuration dialog by right-clicking the object.

- To change the overall appearance and behavior of your KDE desktop, use the Personal Settings that in KDE 4 replaced the former KDE Control Center. Personal Settings offers access to numerous configuration modules and dialogs, some of which can also be accessed via the context menu of individual desktop objects.

3.1 Personal Settings - Overview

The Personal Settings are the central place for users to change the overall appearance and behavior of many components of the KDE desktop. Start the Personal Settings from the main menu by selecting Favorites > Configure Desktop.
3.1.1 Use

The General and Advanced tabs provide different categories of settings. To get an impression of the numerous possibilities, just click a category icon and explore the possibilities provided there. Performing tasks in some areas of the personal settings requires system administrator (root) permissions.

Change the settings as desired. No changes take effect until you click Apply. To discard changes in the recent view that you have not yet applied, click Reset. To reset all items in the recent view to the default values, click Defaults.

To get back to the start-up view (showing all categories) again, click Overview. You can also enter a search string at the top of the window (for example, Screen Saver) to find the category which holds options related to the search string. Each character you enter in the Search field further narrows the search.

For easier overview of all categories, you can also switch to a tree view by clicking Configure and selecting another View Style.
3.1.2 Categories

The following list introduces the major categories, and highlights the most important settings you can change there. If you hover the mouse pointer over the icons in each category, a tool tip shows you which settings can be found there. Detailed information is provided by the Help button on each page of the settings, or in the help center.

The General tab holds the following categories:

Look & Feel
Holds settings for the appearance of your KDE 4 desktop (such as themes, window decorations, and styles of desktop elements). Allows you to configure 3D desktops effects, increase or decrease the number of virtual (multiple) desktops, or configure screen saver options. Cursor behavior, window behavior and the splash screen that appears on KDE start-up can also be modified here.

Personal
Holds settings for changing the default paths to the subdirectories of your home directory. Allows you to change the default applications (like e-mail client, text editor, messenger, and Web browser) that are called whenever a KDE application needs to start applications of these types. Define country and language-specific options here, such as default spell checking options, currency, number and date format, and keyboard layouts for different languages. This category also offers accessibility options for handicapped users, such as sound and keyboard options and mouse gestures.

Network & Connectivity
Allows you to set options for network management, local network browsing and proxy servers.

Computer Administration
Allows you to configure date and time settings for your KDE desktop, to change size and orientation of your display, and to specify power management options for saving energy. Also holds settings for joysticks, keyboard and mouse. You can view and modify the predefined KDE shortcuts. You can also install personal or systemwide fonts here and configure your sound system.

The Advanced tab holds the following categories:
Advanced User Settings

Use this category to configure options like encoding or to which database to con-nect for track listings of audio CDs, to configure your digital camera, or to change the settings for KWallet (the KDE password management tool). If needed, change the default file associations in order to identify a file type and start an appropriate application. Define how KDE handles sessions on login or shutdown and define which applications should be started automatically.

System

Holds options for the login manager, PolicyKit, power management and Samba.

In the following sections, find examples of how to configure some aspects of your KDE desktop that you might want to customize.

3.2 Configuring Desktop Objects and Appearance

Your KDE desktop comes with a predefined set of desktop icons. By adding various objects such as folders, files, or widgets, you can create additional icons on your desktop and arrange them as you like.

Procedure 3.1: Adding Program Icons to the Desktop

To create a link to an application and place it on the desktop or the panel, proceed as follows:

1 Click the main menu button and browse to the desired application.

2 Right-click and select Add to Desktop or Add to Panel from the context menu that appears. If these menu items are not available, your desktop elements are probably locked. Unlock them first as described in Section 1.2.1, “Locking and Unlocking Desktop Objects” (page 7).

   If your desktop objects are not locked, you can also just drag items from the main menu onto the desktop and drop them there to create a link to this application or folder.

3 To change the icon position on the desktop, left-click the icon and drag it to the de-sired place.
3.2.1 Widgets

Procedure 3.2: Adding Widgets to the Desktop

Widgets are small applications that can be integrated into your desktop or your panel.

1 To add widgets to your desktop, right-click an empty patch on your desktop and select Add Widgets.

   If these menu items are not available, your desktop elements are probably locked. Unlock them first as described in Section 1.2.1, “Locking and Unlocking Desktop Objects” (page 7).

2 In the dialog box that appears, you can limit the selection of widgets that is shown with the drop-down list at the top or by entering a search string into the input field.

3 Select a widget and click Add Widget. The widget appears on your desktop.

4 To position the widget on your desktop, left-click the widget and drag it to the desired place.

To remove a widget from your desktop, right-click the widget and select the Remove... entry. Alternatively, hover your mouse pointer over the widget and click the x symbol in the frame.

Procedure 3.3: Configuring Widgets

In order to configure widgets, the desktop elements need to be unlocked as described in Section 1.2.1, “Locking and Unlocking Desktop Objects” (page 7).
To configure a widget, hover your mouse pointer over the widget until a translucent panel appears on the left or right side of the widget, showing a number of symbols.

If the panel does not appear, your widgets are probably locked. Unlock them first as described in Section 1.2.1, “Locking and Unlocking Desktop Objects” (page 7).

To change the widget size, left-click the resize symbol in the panel and keep the mouse button pressed while moving your cursor across the desktop to scale the widget size.

To rotate the widget in any direction, left-click the arrow symbol in the panel and keep the mouse button pressed while moving your cursor in a circle across the desktop. There is a sticky boundary in the horizontal and vertical positions where you can “clamp” the widget, if you like. You can also arrange it in any tilted position.

To change the contents, settings, or properties of a widget, left-click the wrench symbol in the panel. In the configuration dialog box that appears, set the options according to your wishes.

Use the X symbol in the panel if you want to close the widget.
3.2.2 Virtual Desktops, Background and Screen Saver

Procedure 3.4: Changing the Desktop Background

You can change the background colors of your desktop or select a picture to use as the background.

1 Right-click an empty patch of the desktop and select either Desktop Settings, Folder View Settings or Plain Desktop Settings (depending on the currently active desktop view). A configuration dialog appears.

2 In the Wallpaper section, choose an option from the Type drop-down list, for example Image, Slide Show or Color.

- For an image wallpaper, choose a wallpaper from the Picture list. Click Get New Wallpapers to download and install new wallpapers. To use a custom picture, click the folder button beneath the list and select an image file from the file system. Define the Positioning of the image.

- To have multiple images appear in Slide Show mode, define the directory from which to select the pictures and set the interval after which to change the images.
3  Set the other options in the configuration dialog according to your wishes, and click OK to save your changes and leave the configuration dialog.

**Procedure 3.5:**  *Adding Additional Virtual Desktops*

Some users might need more desktops than provided by default.

1  Right-click the desktop previewer in the panel and select *Configure Desktops*. A configuration dialog appears where you can increase or decrease the number of virtual desktops. You can also change the default names of desktops.

![Configuration dialog](image)

2  Click OK to apply the changes and close the configuration dialog.

3  For the names of the desktops to appear in the desktop previewer rather than the number, right-click the desktop previewer and select *Pager Settings > Desktop Name*.

**Procedure 3.6:**  *Using Different Options for Each Virtual Desktop*

Though somewhat more complicated than with KDE 3.x, you can configure your virtual desktops in a way that allows you to use different wallpapers or widgets on each.

**NOTE: Combining Virtual Desktops with Plasma Activities**

Note that the implementation in this release of KDE is still in an experimental state. Some features may not work as expected.
To access the relevant configuration options, you need to show the cashew icon at the upper right corner first. If it is not visible, you need to switch to a different view first. To do so, right-click an empty patch on your desktop and select *Plain Desktop Settings*. In the dialog that appears, click *Type* below *Desktop Activity* and either select *Folder View* or *Desktop* from the list. Click *OK* to confirm the settings and to close the dialog. Now the cashew icon is visible at the upper right corner of your desktop.

1. Click the cashew icon at the upper right corner of your desktop and select *Configure Plasma*.

2. In the Plasma configuration dialog, activate *Different Activity for Each Desktop* and click *OK*.

   From now on, each of your virtual desktops will have separate plasma activities. This will allow you to have a different wallpaper on each virtual desktop, as well as a completely separate set of widgets.

3. Now switch to the virtual desktop you want to configure and set a custom background as described in Procedure 3.4, “Changing the Desktop Background” (page 47) or add new widgets for the virtual desktop as described in Procedure 3.2, “Adding Widgets to the Desktop” (page 45).

To make all virtual desktops appear the same again and to remove the binding between virtual desktops and activities, zoom out of your current desktop again and deactivate *Different Activity for Each Desktop* in the Plasma configuration dialog.

**Procedure 3.7: Configuring the Screen Saver**

SUSE® Linux Enterprise Desktop comes with predefined screen saver settings that you can adjust.

1. Start the Personal Settings from the main menu by selecting *Favorites > Configure Desktop*.

2. On the *General* tab, select *Desktop*.

3. In the dialog that opens, click *Screen Saver*.

4. In the list of screen savers, click a screen saver to see a preview in the right side of the dialog.
5 Click *Setup* to adjust options like speed or shapes.

6 You can also choose to view a blank screen instead or to let KDE start a random screen saver. Find these options at the end of the screen saver list.

7 Under *Settings*, determine after how long a time of inactivity the screen saver should start and whether a password is required to unlock the screen after the screen saver has started.

8 Click *OK* to apply the changes and close the configuration dialog.

### 3.2.3 Panel

You can customize the KDE panel according to your preferences. Applications and widgets can be added to the quick launch area or the system tray in the main panel or to additional panels. Panel elements and additional panels can be moved to different places or be completely removed at any time.

**Procedure 3.8:** *Customizing the Panel*

1 Right-click an empty patch in the panel and select *Panel Options > Panel Settings* to access any panel options. Alternatively, click the cashew icon at the end of the panel. The panel changes view and shows its configurations options.
If the menu item and the icon are not available, your desktop objects are probably locked. To unlock, right-click and select Unlock Widgets first.

2 To move panel objects to a different place within the panel, hover the mouse cursor over the respective panel object (for example, program icon, pager, task manager, system tray). The mouse cursor turns into a crosslines-like form. Move the cursor to the desired position in the panel, then click again to fix the object in the new position.

3 To change the panel width, click and drag the small arrow icons at the far left and right end of the settings panel.

4 To change the panel height, click the Height button and move the mouse pointer to the desired end location.

5 To place the panel at different sides of the screen use the Screen Edge button. Drag and drop the panel to the preferred location.

6 If you need additional widgets on your panel, add them with the Add Widgets... button as described in Step 2 (page 45).

7 To remove program icons or widgets from the panel, right-click the unwanted object and select the menu item to remove the icon or widget.

The icons in the system tray usually belong to applications running in the background. Therefore you can only remove those icons if you close those applications (right-click the icon and select Quit).

8 To prevent the panel and widgets from being moved accidentally, use Lock Widgets.

9 For additional configurations options like alignment and functions (like auto hide), click More Settings.

10 If all panel changes are according to your wishes, close the settings panel with the red close button on the right side.
3.3 Configuring Hardware Components

Most of your hardware components (like mouse, keyboard and display) are configured automatically. In case you need to change any settings, KDE provides a set of options and tools, some of which are integrated into the Personal Settings (like options for mouse and keyboard behavior or the display options). For adjusting your display configuration on the fly, use KRandRTray, the graphical front-end for the RandR (Resize and Rotate) extension of the X server.

3.3.1 Keyboard and Mouse Settings

In the Keyboard & Mouse category of the Personal Settings, you can define options like what happens if you press and hold down a key (keyboard repeat), or what to do with the NumLock toggle key. You can also change keyboard shortcuts as described in Procedure 3.10, “Modifying KDE Keyboard Shortcuts” (page 53) or alter your mouse settings (for example, for left-handed or right-handed use as described in Procedure 3.11, “Adjusting the Mouse Settings” (page 54)). Apart from that, you can adjust or add keyboard layouts in the Regional & Language section of the Personal Settings.

Procedure 3.9: Adjusting and Adding Keyboard Layouts

1. To adjust or add keyboard layouts, open the Personal Settings and select Regional & Language > Keyboard Layout.

2. Activate Enable keyboard layouts at the top.

3. If you have a special Keyboard Model, select the appropriate model from the list, otherwise just keep the default.

4. If you often need to enter texts in various languages, you may want to add different language layouts for your keyboard. To do so, select a layout in the list of Available layouts and click the right arrow button to transfer it to the list of Active layouts.
If you added several layouts, you can change the sorting order with the help of the up and down arrow buttons.

Use the *Switching Options* tab to adjust the options for switching between the keyboard layouts. For example, you can define keyboard shortcuts for switching.

For more information, click *Help*.

Confirm your changes with *Apply*.

If you added keyboard layout, you can change between different keyboard layouts by clicking the country flag in the panel or by using the relevant keyboard shortcut.

**Procedure 3.10: Modifying KDE Keyboard Shortcuts**

KDE comes with a set of predefined keyboard shortcuts. You can easily create more keyboard shortcuts or change existing shortcuts (for example, if they conflict with other application-specific shortcuts).

1. Open the Personal Settings and select *Keyboard & Mouse*.

2. Click either *Standard Keyboard Shortcuts* or *Global Keyboard Shortcuts*. In the *Global Keyboard Shortcuts* category, you can define shortcuts for a number of KDE components like Plasma or the window manager KWin.
For example, to change the shortcuts for switching between the virtual desktops, select the *KWin* entry from the drop-down list. To change the shortcuts for locking the screen or logging out, select the *Run Command Interface* entry.

3. Browse through the list of shortcuts for the selected entry. To filter for certain keywords, enter a search string in the search field above.

4. To change or add a shortcut, select the relevant list entry and in the dialog that opens, select *Custom*.

5. Click the wrench icon to switch to the input mode.

6. Press the desired key or key combination. If this shortcut cannot be accepted or in case of conflict with another existing shortcut, a notification shows. If your input was successful, the new or modified shortcut appears in the list.

7. If you want to switch back to the default keyboard shortcut for the selected action, just click the entry again and select *Default*.

8. To save the modified settings, click *Apply*. To reset all shortcuts to the default values, click *Defaults* then *Apply*.

*Procedure 3.11: Adjusting the Mouse Settings*
1. Open the Personal Settings and select *Keyboard & Mouse > Mouse*.

2. To switch between left-handed or right-handed use, select the corresponding options in the *Button Order* group.

3. To switch to double-clicks to open files and folders, select the corresponding option in the *Icons* group.

4. To change the mouse pointer appearance, switch to the *Cursor Theme* tab and select a different cursor theme.

5. To change the default values of double-click intervals or the distance that the pointer moves over the screen on movement of the mouse, adjust the settings on the *Advanced* tab.

6. Click *Apply* to apply the changes and close the configuration dialog.

### 3.3.2 Monitor Settings

Monitors attached to your machine are detected automatically during installation (or, if you plug them in after the installation, they are detected during the next start of the X server). Configure them with the tools your desktop environment (KDE or GNOME)
provides. To trigger detection of new monitors during a running session, either use the 
$\text{Fn-Fx}$ keys or the RandR desktop tools, KRandRTray or gnome-display-properties.

If you want to set up multiple monitors for dual-head graphics cards, you can choose 
between different modes.

Currently, the following modes are generally supported:

Clone Mode
In this mode, the same content is shown on two or more monitors. Clone mode is 
usually limited to the monitors connected to a single graphics card.

Span View
In this mode, the monitors connected to a graphics card form a single large moni-
tor. You can use 3D acceleration and you can move application windows between 
the screens. Any application that is maximized stretches across the complete desk-
top, not only across one monitor. For this mode, a similar resolution of both moni-
tors is recommended for ease of use.

Twin View
This mode is Nvidia-specific and is a hybrid of Span View and Xinerama: you can 
have 3D acceleration and one desktop stretching over both monitors, but you can-
not rotate just one of them (only both or neither).

---

**NOTE: Available Modes**

Which modes and options are available on your machine depend on your 
hardware (graphics cards and monitors) and the driver you use.

---

**Procedure 3.12: Configuring One or Multiple Monitors**

For configuring multiple monitors, you need a graphics card that is supported by a dri-
ver that implements the RandR extension in version 1.2 or higher. To find out if you 
are using a valid driver, run the `xrandr` command and check the output. If you only 
get a single output that contains the string `default`, your driver only supports RandR 
version 1.1. For illustration, see the examples below.

**Example 3.1: Example Output for a Driver Supporting RandR 1.1**

```
xrandr
$ xrandr
Screen 0: minimum 2048 x 768, current 3360 x 1050, maximum 3360 x 1050
default connected 3360x1050+0+0 0mm x 0mm
```
Customizing Your Settings

Example 3.2: Example Output for a Driver Supporting RandR 1.2

$xrandr
Screen 0: minimum 320 x 200, current 1280 x 1024, maximum 3840 x 1200
DVI-I_1/digital disconnected (normal left inverted right x axis y axis)
DVI-I_1/analog connected 1280x1024+0+0 (normal left inverted right x axis y axis) 338mm x 270mm
1024x768 60.0
800x600 60.3
640x480 59.9
DVI-D_2 disconnected (normal left inverted right x axis y axis) 1280x1024 (0x3e) 108.0MHz
h: width 1280 start 1328 end 1440 total 1688 skew 0 clock 64.0KHz
v: height 1024 start 1025 end 1028 total 1066 clock 60.0Hz

1 Open the Personal Settings and select Display.

2 Select Size & Orientation to configure parameters like dual-head modes, screen size, and refresh rate.

3 Parameters like standby, suspend or power off for your monitor can be configured in the Power Control category.

4 To calibrate your monitor, click the Gamma category. For more information, click Help.

5 In the Multiple Monitors category, you can set some options for application windows (for example, if maximized windows need to be limited to just one monitor).

6 Confirm your settings with Apply.

To adjust your display configuration on the fly, start KRandRTray from the main menu, or press Alt + F2 and enter krandrtray. After you have started the applet, the applet icon is usually added to your system tray. To change screen size or refresh rate, right-click the icon and select one of the entries. After selection, your screen resolution changes immediately and you are asked to confirm the new configuration or to revert to the old one. If you do not confirm the new configuration, the display switches back to the former resolution automatically after 15 seconds. If you left-click the icon, you are taken to the same configuration dialog you can also start from the Personal Settings.
3.3.3 Background Information

The following background information might help you in case your hardware components are not detected correctly by default and you need to adjust some settings manually.

Graphics Card and Display

The following processes are executed by the system to detect and configure your monitor: The X server is responsible for detecting the graphics card. The corresponding driver is selected according to a certain order defining the priorities, for example:

ATI: fglrx --> radeonhd --> radeon --> fbdev --> vesa
NVIDIA: nvidia --> nouveau --> nv --> fbdev --> vesa
VIA: chrome9 --> openchrome --> unichrome
Intel: intel --> fbdev --> vesa

If one of the drivers in the list does not exist or the hardware is not supported, the system tries the next driver. The driver then addresses the monitor in its native resolution. Dynamic changes can be made using desktop-specific tools like gnome-display-properties or KRandRTray.

Mouse, Keyboard and Touchpad

For mouse and keyboard, the evdev driver is used; for notebook touchpads the synaptic driver. The settings are defined systemwide by HAL (hardware abstraction layer) and are stored under /usr/share/hal/fdi/policy.

In case you need to adjust your (static) X Window System configuration for hardware components, this can be done with a graphical front-end (SaX2) or by editing the /etc/X11/xorg.conf configuration file manually (for experts only). To start SaX2, press Alt + F2 and enter sax2 (root password needed).

For experienced users, there are also command line tools available: you can set the keyboard with setxkbmap or test and configure XInput devices with xinput.

3.4 Configuring Behavior and System Aspects

Procedure 3.13: Changing Default Applications
There are certain default applications defined in KDE: For example, when you click an e-mail address, KMail starts.

1 To change this behavior and set your preferred Web browser or e-mail client as default, open the Personal Settings and click Default Applications.

2 To change the Web browser:

   2a In the list of components, select Web Browser.

   2b Select Open http and https URLs in the following browser and click the browse button beneath.

   2c A dialog opens, showing the main menu structure. Select the Web browser to set as default and click OK. The component chooser now shows the selected application in the display field.

3 To change the e-mail client:

   3a In the list of components, select Email Client.

   3b Select Use a different email client and click the browse button.

   3c A dialog showing the main menu structure opens. Select the e-mail client to set as default and click OK. The component chooser now shows the selected application in the display field.
4 If desired, change other default applications for KDE, like the application for the terminal window or the instant messenger client.

5 When all options are set according to your wishes, click Apply.

**Procedure 3.14: Changing File Associations**

Similar to setting the default Web browser or e-mail application, you can change file associations in KDE. File associations determine which application should be used to open a specific file type.

1 Open the Personal Settings, click the *Advanced* tab and select *File Associations*.

2 To search for an extension, enter the extension in *Find File Type or File Name Pattern*. Only file types with a matching file pattern appear in the list. For example, to modify the application for *.png files, enter *png* in *Find File Type or File Name Pattern*.

3 In the *Known Types* list, click the file type to open the setting dialog for this file type. You can change the icon, filename patterns, description, and the order of the applications.

If your tool is not listed, click *Add* in *Application Preference Order* then select the program for the file type.
To change the order of the list entries, click the program to move. Give it a higher or lower priority by clicking *Move Up* or *Move Down*. The application listed at the top is used by default when you click a file of this type.

4 When all options are set according to your wishes, click *Apply*.

**Procedure 3.15:** *Adjusting Regional Settings*

To adjust settings such as time and date format, number format, or currency, select the desired country as the default country in KDE. If more than one system language is installed on your computer, you can also select the different languages in which KDE should show the graphical user interface and application interfaces.

1 To set your default country options, open the Personal Settings and select *Regional & Language*.

2 On the *Locale* tab, click *Change* next to the *Country or Region* entry. In the dialog that opens, select the region and country you want to set as default in KDE and click *OK*.

Number, date and time formats are automatically adjusted to the new country's default values that are shown in the display field at the bottom of the *Locale* tab.
If you need to make further adjustments for those, click the relevant tabs and set the options according to your wishes.

If more than one language is installed on your system (as secondary languages with YaST) and you want to change the graphical interface of KDE to a different language, click Add Language on the Locale tab. This opens a list of languages currently installed on your system.

Select the language for the graphical user interface. The new language is now shown at the top position in the Language list.

To confirm the changes, click Apply. All newly started applications or desktop objects now appear in the new language.

To switch to another language, re-sort the languages in the Languages list until the desired language is at the top position and apply your changes.

KDE runs a session manager that starts after your username and password are authenticated by the login process. It lets you save the status of a certain session and return to that status the next time you log in. For example, it can automatically start the applications that you were running in the most recent session or when you manually saved a session. It can save and restore the following settings:

- Appearance and behavior settings (such as fonts, colors, and mouse settings).
- Applications that you were running (such as a file manager or LibreOffice).

**NOTE: Saving and Restoring Applications**

You cannot save and restore applications that Session Manager does not manage. For example, if you start the vi editor from the command line in a terminal window, Session Manager cannot restore your editing session.

**Procedure 3.16: Adjusting the Session Handling**

To change the session handling options, open the Personal Settings and on the Advanced tab, click Session Manager.

By default, Session Manager restores the applications that were running when you logged out from the previous session, enabling an automatic start of these applications.
2 To be able to save a certain session manually and restore this session each time you log in to KDE, select *Restore manually saved sessions*. This adds a new menu item, *Save Session*, to your main menu. After a session is saved, KDE automatically restores the saved session on each login.

3 To start with a “fresh” session each time you log in, select *Start with an empty session*.

4 To change the default options that appear when logging out, adjust the relevant options in the *General* and *Default Leave Option* groups.

5 Click *Apply* to confirm your changes.

**Procedure 3.17: Starting Programs Automatically**

Apart from the applications from the last session that are restored by the Session Manager, you can configure which applications should be always be started after login.

1 Open the Personal Settings and on the *Advanced* tab, click *Autostart*.

2 To add an application, click *Add Program* and from the menu structure, select the program you want to start automatically.

To add a shell script, click *Add Script* and click the *Open File Dialog* icon in the next window to select the script from the file system. The program or script is added to the list and you can view and change the *Status*. 
3 Click *Apply* to confirm your changes. When logging in the next time, the applications and scripts start automatically.
Part II. Managing
Files and Resources
Viewing PDF Files and Other Documents with Okular

Apart from PDF files, Okular allows you to view a great number of file formats, such as PostScript, several image formats, OpenDocument format (ODF), OpenDocument text (ODT), some eBook formats (ePub), and even Microsoft* Compiled HTML Help (CHM). Okular also provides support for bookmarks, annotations, form fields, multimedia content, and rotation of pages.

4.1 Viewing PDF Files

Documents that need to be shared or printed across platforms can be saved as PDF (Portable Document Format) files, for example, in the OpenOffice.org suite. View them with Okular, the default KDE document viewer.

Start Okular from the main menu or press Alt + F2 and enter okular. To open a document, select File > Open and choose the desired file from the file system. Navigate through the document by using the navigation icons at the top or bottom of the window. Depending on which icon you click on the navigation panel on the left, the sidebar either shows a table of Contents, a Thumbnails view of each page, the Reviews for this file, or your Bookmarks for this file. To filter for any text listed in the sidebar or the overall document, enter a string into the input field at the top of the sidebar. If you want to select and copy text or images from the file in Okular, click the Selection icon in the toolbar and select one of the options from the context menu. Click the Browse icon to switch back to browsing the document.
4.2 Annotating a PDF File

With Okular, you can review a document by highlighting certain text parts or adding annotations or bookmarks that Okular then attaches to the file in form of metadata. Note that the annotations and markers you add are not stored within the document, so you cannot print them or pass them on to other users.

To create an annotation for a page, press F6 and select one of the annotation tools from the toolbar that appears. The annotation is added to the list of Reviews and is flagged with the login name of the user who created it. Use the icons at the bottom of the sidebar to group the annotations by page, by author or to show the annotations for the current page only.
4.3 For More Information

See the home page http://okular.kde.org of Okular for more information. The supported formats can be viewed at http://okular.kde.org/formats.php.
Accessing Network Resources

From your desktop, you can access files and directories or certain services on remote hosts or make your own files and directories available to other users in your network. SUSE® Linux Enterprise Desktop offers various different ways of accessing and creating network shared resources:

Network Browsing
Your file managers, Dolphin or Konqueror, let you browse your network for shared resources and services. Learn more about this in Section 5.2, “Accessing Network Shares” (page 73).

Sharing Folders in Mixed Environments
Using Dolphin or Konqueror, configure your files and folders to share with other members in your network. Make your data readable or writable for users from any Windows or Linux workstation. Learn more about this in Section 5.3, “Sharing Folders in Mixed Environments” (page 73).

Managing Windows Files
SUSE Linux Enterprise Desktop can be configured to integrate into an existing Windows network. Your Linux machine then behaves like a Windows client. It takes all account information from the Active Directory domain controller, just as Windows clients do. Learn more about this in Section 5.4, “Managing Windows Files” (page 76).

Configuring Shortcuts to Network Folders
By creating shortcuts to remote network folders (FTP, WebDAV, Windows Network Drives, and SSH), interacting with them can be greatly simplified.
Learn how to configure this in Section 5.5, “Configuring Shortcuts to Network Folders” (page 80).

---

**NOTE: Network Share Support in Dolphin**

Dolphin is KDE 4's default file manager and most of the network functions described in this chapter are already integrated. However not all of them might work flawlessly—if in doubt, try using Konqueror instead.

---

### 5.1 General Notes on File Sharing and Network Browsing

Whether and to what extent you can use file sharing and network browsing on your machine and in your network highly depends on the network structure and on the configuration of your machine. Before setting up either of them, contact your system administrator to make sure that your network structure supports this feature and to check whether your company's security policies permit it.

Network browsing, be it SMB browsing for Windows shares or SLP browsing for remote services, relies heavily on the machine's ability to send broadcast messages to all clients in the network. These messages and the clients' replies to them enable your machine to detect any available shares or services. For broadcasts to work effectively, your machine must be part of the same subnet as all other machines it is querying. If network browsing does not work on your machine or the detected shares and services do not match with what you expected, contact your system administrator to make sure that you are connected to the appropriate subnet.

To allow network browsing, your machine needs to keep several network ports open to send and receive network messages that provide details on the network and the availability of shares and services. The standard SUSE Linux Enterprise Desktop is configured for tight security and has a firewall up and running that protects your machine against the Internet. To adjust the firewall configuration, you would either need to ask your system administrator to open a certain set of ports to the network or to tear down the firewall entirely according to your company's security policy. If you try to browse a network with a restrictive firewall running on your machine, Dolphin warns you about security restrictions not allowing it to query the network.
5.2 Accessing Network Shares

Networking workstations can be set up to share folders. Typically, files and folders are marked to let remote users access them. These are called network shares. If your system is configured to access network shares, you can use your file manager to access and browse them just as easily as if they were located on your local machine. Having read or write access to the shared folders depends on the permissions granted to you by the owner of the shares.

To access network shares, start Dolphin and click the Network icon in the Places panel or enter `remote:` / in the location bar. Dolphin then opens a virtual folder that displays the network share types that you can access. Click a network resource type then click the network share to access. You might be required to authenticate to the resource by providing a username and password.

Figure 5.1: Network Browsing

5.3 Sharing Folders in Mixed Environments

Sharing and exchanging documents is a must-have in corporate environments. Dolphin offers you file sharing with Samba, which makes your files and folders available to both Linux and Windows users. For information on how to install and set up Samba, refer to Chapter 27, Samba (↑Administration Guide). After you have installed Samba
and set up a server, you can configure the folders to share with Dolphin. Dolphin then writes its configuration to a paragraph in the main Samba configuration file at /etc/samba/smb.conf.

**Procedure 5.1:** Configuring Samba File Shares with Dolphin

1. Open Dolphin.

2. Select *Home*, right-click the window background and then select *Properties* from the context menu.

3. In the *Properties* dialog, click the *Share* tab. If file sharing is not yet enabled, you are alerted to this on the tab. To enable file sharing or select the files to share, click *Configure File Sharing* and enter the *root* password.

4. To enable or disable file sharing, select or deselect *Enable Local Network File Sharing*.

**Figure 5.2:** Enabling File Sharing

5. Select the appropriate sharing option: *Simple Sharing* or *Advanced Sharing*.

6. To limit the number of users allowed to share folders to certain groups, click *Allowed Users*, select *Only users of a certain group are allowed to share folders*, click
Choose Group, and select the appropriate group from the list in the window that opens. Click OK to close that window.

7 In the File Sharing dialog, add the folder to share to the list of shared items by clicking Add at the bottom of the dialog and specifying the folder's exact path.

**Figure 5.3:  Detailed Sharing Options**

8 Activate Share with Samba to enable Samba file sharing. If needed, apply some fine-tuning to the Samba options:

*Name*

Specify a name other than the preset default.

*Public/Writable*

Determine which kind of access to grant others to your share. You can grant users full read and write access or limit their access to read-only.

9 Apply your settings and leave the file sharing dialog with OK.

The folder now appears in Dolphin with a globe icon.
To revoke the share, enter the file sharing dialog again and remove the folder from the list of shared items. The folder then appears without a globe icon.

Other members of your network can reach your share by entering `smb://` in the location bar of Dolphin and clicking the appropriate workgroup icon and hostname.

**IMPORTANT: Samba Domain Browsing**

Samba domain browsing only works if your system's firewall is configured accordingly. Either disable the firewall entirely or assign the browsing interface to the internal firewall zone. Ask your system administrator about how to proceed. This procedure is described in more detail in Section “Configuring a Linux Client for Active Directory” (Chapter 5, *Active Directory Support*, ↑Security Guide).

### 5.4 Managing Windows Files

With your SUSE Linux Enterprise Desktop machine being an Active Directory client as described in Chapter 5, *Active Directory Support* (↑Security Guide), you can browse, view, and manipulate data located on Windows servers. The following examples are just the most prominent ones:

**Browsing Windows Files with Dolphin**

Use Dolphin’s `smb://` browsing option to browse your Windows data.
Viewing Windows Data with Dolphin

Use Dolphin to display the contents of your Windows user folder just as you would for displaying a Linux directory. Create new files and folders on the Windows server.

Manipulating Windows Data with KDE Applications

KDE applications, such as the Kate text editor, allow you to open files on the Windows server, manipulate them, and save them to the Windows server.

Single-Sign-On

KDE applications (including Dolphin) support Single-Sign-On, which means that to access other Windows resources, such as Web servers, proxy servers, or groupware servers like MS Exchange, you do not need to reauthenticate. Authentication against all these is handled silently in the background after you provide your username and password on login.

Procedure 5.2: Accessing Windows Data with Dolphin

1. Press Alt + F2 and enter smb:/ or start Dolphin and enter smb:/ in the location bar.

Dolphin displays all Samba workgroups and domains that could be found in your network.

2. Click the icon of the workgroup or domain of your AD server.

Figure 5.5: Browsing Data on the AD Server
3 Click the *Users* folder and select your personal user folder icon. The contents of your *My Documents* folder are displayed.

To create folders in your Windows user folder, proceed as you would when creating a Linux folder:

1 Right-click the background of the Dolphin folder view to open the menu.

2 Select *Create New > Folder*.

3 Enter the new folder's name when prompted to do so.

To create a file on the AD server, proceed as described in the following example for the KWrite text editor.

1 Press Alt + F2 and enter `kwrite`.

2 Enter your text.

*Figure 5.6:* Editing a Text File with KWrite

3 To save the newly created text, select *Save as*.

4 Click the *Network* icon in the *Places* view and select *SMB Shares*. 
5 Navigate to your Windows folder.

6 Enter the filename and click Save.

   The file is saved on the Windows server.

Make use of Dolphin's Single-Sign-On support, as in the following example—Web access to your MS Exchange mailbox:

1 Make sure that you have a valid MS Exchange account under your current Windows user identity.

2 Request the Exchange server's address from your system administrator.

3 Press Alt + F2 and enter dolphin http://address_exchange_server.

   You are logged in to your Exchange account without having to reauthenticate.

4 Write or read your e-mails and log out as usual.
5.5 Configuring Shortcuts to Network Folders

With KNetAttach, you can also add new network folders to this view by clicking *Add a Network Folder* in a Dolphin `remote:` / view. A wizard opens where you can select the type of network folder to access and enter the details, such as a name for the network folder, the address of the server (either the IP address or domain name), the login name, the port, and the path to folder to access.

*Figure 5.8:  Adding a Network Folder*

After finishing, you can access the network share in Dolphin by clicking *Network* in the *Places* panel.

If you add a network folder in this way, you can also access this folder easily when opening or saving a file from a KDE application. If you click *Network* in the left-hand bar of an *Open File* or a *Save File* dialog, the network folder you added appears.

---

**TIP: Linking to Network Shares on the Desktop**

For quick access to network shares, you can also create links to these resources on your desktop. To do so, select the desired resource in Dolphin and drag it onto your desktop while keeping the left mouse button pressed. From the context menu, select *Icon* or *Folder View* to either display the folder as icon or in the folder view, directly displaying the contents of the directory.
Searching with Kerry

Kerry is a KDE front-end for the Beagle search tool, which indexes your personal information space to help you find whatever you need. You can use Kerry to find documents, e-mails, Web history, IM/ITC conversations, source code, images, music files, applications, and much more.

Because Kerry is a front-end to Beagle, it needs the beagle daemon to be functional. Kerry and Beagle can now index many KDE-specific sources of information, such as Kopete conversations, Konqueror history, or KMail messages. The result is a smooth integration into the KDE environment through the Kerry interface. Find more about Beagle in Chapter 6, Searching with Beagle (↑GNOME User Guide).

6.1 Searching Using Kerry

To find data using the Kerry tool, follow these steps:

1 Press Alt + F2 and enter kerry to start Kerry and to open the Kerry Beagle Search window. Alternatively, open the search window by left-clicking on the Kerry applet icon (a dog's head) in the system tray.

2 Enter the term to find in Search. To quickly clear the previously entered text, press the black arrow on the left.

The search is not case-sensitive. To search for optional terms, use the OR keyword (in uppercase). For example, Mars OR Venus finds all data containing any occurrence of Mars, Venus, or both. To exclude search terms, use a minus symbol (−) in front of them. For example, Mars −Venus finds all data containing any occur-
rence of Mars but without any occurrence of Venus. To search for an exact phrase, enclose the phrase in quotes. If you want to include only certain file type in results, specify the filename extension with \textit{ext:}. For example, \textit{Mars ext:xml} finds xml files containing Mars.

3 Select the scope of the search in the \textit{Show} section of the right panel. To search all the indexed content, choose \textit{Everything}. However, you can limit the search only to indexed \textit{Applications}, \textit{Contacts}, \textit{Office Documents}, instant messenger \textit{Conversations}, \textit{Images}, \textit{Media files}, \textit{Web Pages}, or \textit{File/Path Names} by clicking the appropriate item in the panel. You can change the scope before or after the search is performed.

Change the sort order of results in the \textit{Sort By} section of the right panel. To sort results by type, click \textit{Type}. Sorting by \textit{Date}, \textit{Name}, and \textit{Relevance} is also possible. You can change the sort order before or after the search is completed.

You can limit the results by date of last modification. To show all results regardless of the date of the last modification, click \textit{Any Date} in the right panel. You can show items modified today, since yesterday, this week, month, or year by clicking the appropriate item in the right panel. You can change this before or after the search is performed.

4 Press \textit{Enter} or click the icon to the right of the search field to start the search. Results are displayed in the main area of the window.

Results are displayed in a window, sorted according to your settings. Click any item to activate it. To open a folder containing a found file instead of the file itself, click the name of the folder to the right of the filename. To display more information about an item, click the icon with the $i$ on the left.

You can change the scope of the search, sort order, or limitation by date at any time by clicking appropriate item in the panel on the right.

Use \textit{Previous results} and \textit{Next results} to move between pages of the result list. The number of items found is shown in the bottom part of the window.

6.2 Configuring Kerry

You can configure Kerry by right-clicking its icon in the tray and choosing \textit{Configure Kerry} or by clicking \textit{Configure} in Kerry's main window. The configuration dialog has four tabs.
On the Search tab, you can change the Default result sort order, Maximum number of results displayed on one page, or shortcuts for activating Kerry Beagle Search.

On the Indexing tab, set whether the Beagle indexing service should be started automatically and if data should be indexed while the computer is operating on battery power. You can also determine which folders should be indexed by Kerry Beagle Search and which folders should not be indexed at all. See Section 6.2.1, “Indexing More Directories” (page 83) and Section 6.2.2, “Preventing Files and Directories from Being Indexed” (page 83) for detailed instructions.

On the Backends tab, choose which of the available Beagle back-ends should be enabled. To disable a back-end, uncheck it. For example, if you do not want your Kopete conversations be indexed by Kerry Beagle, uncheck the Kopete back-end.

On the Daemon Status tab, check the status of Beagle daemon. You can stop or start the daemon manually here. To use Kerry Beagle Search functionality, the daemon must be running.

### 6.2.1 Indexing More Directories

By default, Kerry indexes your home folder only. If you do not want your home folder to be indexed, uncheck the Index my home folder option on the Indexing tab of the Kerry configuration. To index more folders, follow these steps:

1. Right-click the Kerry icon in the tray and choose Configure Kerry.
2. Click the Indexing tab.
3. Click the Add button in the middle part (Index) of the tab.
4. In the dialog that opens, choose the folder to index and click OK.
5. Press OK.

### 6.2.2 Preventing Files and Directories from Being Indexed

To exclude some folders or files from being indexed by Kerry, follow these steps:
1 Right-click the Kerry icon in the tray and choose *Configure Kerry*.

2 Click the *Indexing* tab.

3 Click *Add* in the bottom part (*Privacy*) of the tab.

4 In the dialog that opens, choose a folder not to index by selecting the *Folder* option. Specify the path to the folder in the text field or press the folder button and choose the folder in a file dialog.

   You can also specify files not to index by selecting *File name pattern* and specifying the file pattern.

5 Press *OK*. 
Managing Print Jobs

Printers can either be connected to your system locally or over a network. There are several ways to set up a printer in SUSE Linux Enterprise Desktop: with YaST, or on the command line. There are also desktop tools in KDE or GNOME for setting up printers but we recommend to use YaST for this task.

Refer to Section “Setting Up a Printer” (Chapter 5, Setting Up Hardware Components with YaST, Deployment Guide) for detailed information how to configure printers with YaST.

**NOTE: Troubleshooting**

If you have problems configuring your printer, ask your system administrator. An in-depth coverage of printer configuration for administrators can be found in Chapter 15, Printer Operation (Administration Guide).

The KDE print dialog is started automatically each time you print from a KDE application.

**Figure 7.1:** KDE Print Dialog
The *Name* drop-down list shows all printers that have been configured for your computer (either local printers or network printers). It also allows you to print contents to a PDF or PostScript file. To print to a file, choose the respective entry and specify a location for the *Output File*. Otherwise, choose one of the available printers and edit the *Properties* of your print job, such as page orientation, paper size or print margins.

To specify the number of copies and various other options, click *Options* at the bottom left. The window then expands and shows several tabs. The available tabs and options depend on both your printer model and on the application you started the print dialog from.

**Figure 7.2:** *KDE Print Options*

On the *Copies* tab, set the *Print Range* (which pages of the document to print) and the number of copies. Switch to the *Options* tab to define special settings such as *Duplex Printing* or *Color Mode* (if supported by your printer model). The *Pages* tab lets you specify if to print multiple pages per sheet (if supported by your printer model). The other tabs provide even more options, but they are rarely needed. If all options are set according to your wishes, click *Print* to start the print job. Currently, it is not possible to save your print options in the KDE 4 print dialog (like KPrinter allows for KDE 3.x).
Managing Passwords with KWallet Manager

Remembering all the passwords for protected resources to which you need to log in can be problematic. KWallet remembers them for you. KWallet is a password management tool that can collect all passwords and stores them in an encrypted file. With a single master password, open your wallet to view, search, delete, or create entries.

IMPORTANT: Protect Your KWallet Password

If you forget your KWallet password, it cannot be recovered. Furthermore, anyone who knows your password can obtain all information contained in the wallet.

8.1 Starting KWallet

When you enter a password in a KDE application for the first time (in KMail or Konqueror, for example), you are asked if you want to store the password in an encrypted wallet. If you click Yes, the KWallet wizard starts by default. KWallet is a password management tool that can collect all passwords and store them in an encrypted file.
To activate KWallet, select *Basic Setup* and click *Next*. Select *Yes, I wish to use the KDE wallet to store my personal information* and enter a password. This is your master password to open KWallet. It cannot be recovered if you forget it. Click *Finish* to close the wizard. After this initial configuration, you can open your wallet at any time to view, search, delete, or create entries. Normally you do not need to insert an entry manually. KDE recognizes if a resource requires authentication and KWallet starts automatically, prompting you for the KWallet password. Of course, you can also use KWallet to store additional passwords by adding entries, as described in Procedure 8.1, “Adding New Entries to Your Wallet” (page 89).

By default, all passwords are stored in one wallet, *kdewallet*, but you can also add new wallets. Once configured, KWallet appears in the panel. You can also start KWallet manually by pressing *Alt + F2* and entering *kwalletmanager*.

### 8.2 Managing Your Passwords

To store data in your wallet or view its contents, click the KWallet icon in the panel. A dialog box opens, showing the wallets that are accessible on your system. Click the wallet to open. A window prompts for your password.

After a successful login, the KWallet Manager window opens. In the tree view on the left, navigate to the entry for which you want to view or change the password. For safety reasons, the password value is hidden by default when you click the entry. For passwords, click *Show Contents*. For maps, containing key and value pairs (like a WLAN ESSID and your password), activate *Show Values* to view the contents.
**Procedure 8.1: Adding New Entries to Your Wallet**

1. To manually add new passwords (or maps) to KWallet, select the subfolder to which to add an entry in the tree folder at the left.

2. To add a new password, right-click a **Passwords** entry and select **New** from the context menu.

   To add a new key pair (map), right-click a **Map** entry and select **New** from the context menu.

3. Specify a name for the new entry then click **OK**. Your new entry is sorted under your folder entry.

4. Click the new entry to display it on the right side (the folder is initially empty).

5. Click **Show Contents** or **Show Values** to open an input field where you can enter your new password or values.

6. To add a key pair, right-click the empty input field and select **New Entry** Type in your password (or you key and respective value for that key) and click **Save**. KWallet saves your entry to the subfolder selected.

**Procedure 8.2: Changing the Password for a Wallet**

If needed, you can change your password for a wallet at any time.

1. Open KWallet Manager and right-click the wallet for which to change the password.
2 Select *Change Password*.

3 Enter your new password twice.

### 8.3 Adjusting KWallet Settings

By default, you define the settings for KWallet password manager with the help of a wizard when you use KWallet for the first time. You can adjust the initial settings at any time to increase security.

1. If KWallet is already started, click the KWallet symbol in the panel and select *Configure Wallet*. Otherwise, in the main menu, select *Configure Desktop* and on the *Advanced* tab, click *KDE Wallet*.

2. If KDE wallet subsystem is not yet enabled, activate the relevant check box at the top.

3. By default, a wallet is closed when the last application stops using it. To increase security, you can set a more restrictive policy: to close a wallet automatically after a period of inactivity or after start-up of the screen saver, activate the relevant check boxes.

4. By default, KWallet stores all passwords in one wallet named `kdewallet`. To store local and network-related passwords in different wallets, activate *Different wallet for local passwords*. Click *New* to create an additional wallet, if needed.
To remove the KWallet icon from the panel, deactivate *Show manager in system tray*. You can then only access KWallet from the main menu.

### 8.4 Copying Your Wallet to Another Computer

For the most part, KWallet resides silently in the panel and is automatically activated if needed. However, you can copy your wallet files to another computer (for example, your laptop). To simplify this task, wallets can be dragged from the manager window to a file browser window. This lets you easily package a new wallet for transfer to another environment. For example, a new wallet could be created and copied onto a removable flash memory device. Important passwords could be transferred there, so you have them available in other locations.
Controlling Your Desktop's Power Management

In KDE 4, you can control power management functions supported by your system with just a few clicks on the desktop. You can choose between various power management profiles to match the tasks your system is facing. The Personal Settings hold a Power Management category, allowing you to configure detailed settings as described in Section 9.3, “Configuring Power Management” (page 96).

Apart from power profiles that can be applied while you are interacting with your computer, there are also power saving functions (suspend modes) you can use instead of shutting down the computer completely during breaks.

9.1 Using the Battery Monitor Widget

If you are using mobile computers like a laptop, a widget in your panel displays the battery status and gives you access to power management functions. If the Battery Monitor widget is not displayed in your panel by default, add it manually. For more information, refer to Procedure 3.2, “Adding Widgets to the Desktop” (page 45).

The widget allows you control the screen brightness when your system is running on battery power, to switch to a different power profile, or to trigger your system to enter a suspend mode. Click the panel icon to open the widget.
Which suspend modes and power profiles are available depends on the power management abilities of your system and the profiles defined in the *Personal Settings*.

The following suspend modes are widely available:

* **Sleep (Suspend to RAM)**
  Pauses your computer without logging you out. All your data and the session data is saved to RAM. Bringing the system up again is faster than restoring a session from disk.

* **Hibernate (Suspend to Disk)**
  Pauses your computer without logging you out. All your data and the session data is saved to disk before the system is laid to rest. It is thus protected against data loss should you lose power in the meantime. Waking the system up again is much faster than with a fresh boot.

To manually suspend your computer, use the buttons in the widget or the suspend options on logging out (see Section 1.3, “Leaving Your System” (page 13)). If supported by the system and configured accordingly, pressing sleep buttons on your machine or keyboard will also suspend your machine.

You can configure your system to automatically switch to suspend mode after certain events like closing the lid (if you are using a laptop) or after a period of...
that time that the system has been idle. Refer to Section 9.3, “Configuring Power Management” (page 96) for more information.

9.2 Saving Power by Using Profiles

Power management profiles let you adjust various power management parameters to the requirements of certain typical situations you are facing when using your machine. SUSE® Linux Enterprise Desktop ships with a set of four pre-configured profiles which you can adjust to your needs. To switch profiles, click the battery monitor panel icon and select a different Power Profile. The following profiles are available by default:

Performance
   Keep your machine running with full power and full speed to achieve maximum performance.

Presentation
   Disable any display power management and screen savers to make sure that your presentation is not interrupted by a blanked display or something similar.

Powersave
   Apply power management methods to make sure that your machine runs as long as possible when put on battery power instead of AC power.

Aggressive Powersave
   Apply stricter power management methods when the battery is at a low level. These include shorter idle intervals before triggering suspend events, reducing screen brightness, disabling 3D effects and using CPU scaling policies that preserve resources.

Xtreme Powersave
   Apply extreme power saving by reducing screen brightness even more and using stricter idle time and CPU scaling policies when the battery is already at warning level.
9.3 Configuring Power Management

KDE 4 lets you adjust a number of power management settings: for example, when to trigger notifications or warnings, which power profile to use when running on battery, what to do when closing the laptop lid or pressing the power or sleep button.

Access the configuration options from the main menu by selecting Configure Desktop > Advanced > Power Management. Alternatively, click the battery monitor icon in the panel and click select More.

Figure 9.2:  Power Management Settings

To get an overview of your system's power management abilities like supported suspend methods or CPU policies, click the Capabilities category on the left.

In the following, find some examples of which aspects can be changed in the General Settings category and how to configure power management profiles.
**Procedure 9.1: Configuring General Settings**

To access the following options, click the *General Settings* entry on the left side of the power management configuration dialog.

1. In the *Settings and Profiles* group, decide if the screen should be locked after a suspend action, so that the user needs to type in his password when the machine resumes after a suspend.

2. Configure which notifications or warnings you want to receive for certain events (like low battery status), or if you want suspend actions to be executed immediately or only after a certain time interval.

3. In *Profile Assignment*, decide which power profiles should be applied by default when the system is running on AC power, on battery, or when the battery is low or at warning level.

4. Click *Advanced Battery Settings* if you want to fine-tune the battery levels that are regarded as low or critical or to define which action should be taken at a critical battery level.

5. For detailed information about the available options, click *Help*.

6. If all options are set according to your wishes, click *Apply*.

**Procedure 9.2: Configuring Power Management Profiles**

Apart from the general settings, you can adjust the default power management profiles or add new profiles in the *Edit Profiles* category. The list at the left show the available profiles.

1. Select one of the profiles in the list to view or change the specific settings for that profile:

   1a. In the *Actions* group, decide which actions are taken when the lid of the laptop is closed or the *Power* or *Sleep* button is pressed.

   1b. In the *Screen* group, configure how much the screen is dimmed and after how many minutes the display is turned off automatically.
1c Click *CPU and System* to view or change which CPU to turn off (if supported by your machine) or to set the CPU frequency scaling policy for that profile.

2 Use the icons at the bottom of the list of profiles if you want to add, delete, import or export power management profiles.

3 If all options are set according to your wishes, click *Apply*.

### 9.4 For More Information

For detailed and more technical information about power saving functions, see Chapter 21, *Power Management* ([Administration Guide](#)).
GNU Licenses

This appendix contains the GNU Free Documentation License version 1.2.

GNU Free Documentation License

Copyright (C) 2000, 2001, 2002 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA. Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document "free" in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated herein. The "Document", below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as "you". You accept the license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A "Modified Version" of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document's overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License. If a section does not fit the above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.
The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A "Transparent" copy of the Document means a machine-readable copy, represented in a format whose specification is available to the general public, that is suitable for revising the document straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent. An image format is not Transparent if used for any substantial amount of text. A copy that is not "Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, TeXinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF and JP2. Opaque formats include proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, "Title Page" means the text near the most prominent appearance of the work's title, preceding the beginning of the body of the text.

A section "Entitled XYZ" means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific section name mentioned below, such as "Acknowledgements", "Dedications", "Endorsements", or "History".) To "Preserve the Title" of such a section when you modify the Document means that it remains a section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies. If you publish a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more than 100, and the Document's license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a computer-network location from which the general network-using public has access to download using public-standard network protocols a complete Transparent copy of the Document, free of added material. If you use the latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:
A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has fewer than five), unless they release you from this requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document's license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled "History", Preserve its Title, and add to it an item stating at least the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled "History" in the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network locations given in the Document for previous versions it was based on. These may be placed in the "History" section. You may omit a network location for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of the section, and preserve in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered part of the section titles.

M. Delete any section Entitled "Endorsements". Such a section may not be included in the Modified Version.

N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in title with any Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version's license notice. These titles must be distinct from any other section titles.

You may add a section Entitled "Endorsements", provided it contains nothing but endorsements of your Modified Version by various parties—for example, statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add another, but you may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled "History" in the various original documents, forming one section Entitled "History"; likewise combine any sections Entitled "Acknowledgements", and any sections Entitled "Dedications". You must delete all sections Entitled "Endorsements".
6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License, and replace the individual copies of this License in the various documents with a single copy that is included in the collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you insert a copy of this License into the extracted document, and follow this License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution medium, is called an "aggregate" if the copyright resulting from the compilation is not used to limit the legal rights of the compilation's users beyond what the individual works permit. When the Document is included in an aggregate, this License does not apply to the other works in the aggregate which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one half of the entire aggregate, the Document's Cover Texts may be placed on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include a translation of this License, and all the license notices in the Document, and any Warranty Disclaimers, provided that you also include the original English version of this License and the original versions of those notices and disclaimers. In case of a disagreement between the translation and the original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements", "Dedications", or "History", the requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License "or any later version" applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose any version ever published (not as a draft) by the Free Software Foundation.

ADDENDUM: How to use this License for your documents

Copyright (c) YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.2
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled “GNU
Free Documentation License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with...Texts.” line with this:
with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your choice of free software license, such as the GNU General Public License, to permit their use in free software.